## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>v</td>
</tr>
<tr>
<td><strong>Chapter 1. Components used by IBM Cognos Business Viewpoint Server</strong></td>
<td>1</td>
</tr>
<tr>
<td>Components installed with IBM Cognos Business Viewpoint Server</td>
<td>1</td>
</tr>
<tr>
<td>Components not installed with IBM Cognos Business Viewpoint Server</td>
<td>1</td>
</tr>
<tr>
<td><strong>Chapter 2. Installation and testing checklist for Cognos Business Viewpoint</strong></td>
<td>3</td>
</tr>
<tr>
<td><strong>Chapter 3. Upgrading Cognos Business Viewpoint</strong></td>
<td>5</td>
</tr>
<tr>
<td>Upgrading Cognos Business Viewpoint 8.4</td>
<td>6</td>
</tr>
<tr>
<td>Upgrading Cognos Business Viewpoint 8.4.1 or a later version</td>
<td>8</td>
</tr>
<tr>
<td><strong>Chapter 4. Distribution options for IBM Cognos Business Viewpoint Server</strong></td>
<td>11</td>
</tr>
<tr>
<td>IBM Cognos Business Viewpoint Server and database server on one computer</td>
<td>11</td>
</tr>
<tr>
<td>IBM Cognos Business Viewpoint Server and database server on separate computers</td>
<td>12</td>
</tr>
<tr>
<td>Integration with IBM Cognos Business Intelligence</td>
<td>13</td>
</tr>
<tr>
<td><strong>Chapter 5. Installation requirements to move fact data into IBM Cognos TM1</strong></td>
<td>15</td>
</tr>
<tr>
<td><strong>Chapter 6. Setting up your environment</strong></td>
<td>17</td>
</tr>
<tr>
<td>Reviewing software and hardware requirements for Cognos Business Viewpoint Server</td>
<td>17</td>
</tr>
<tr>
<td>Creating the IBM Cognos Business Viewpoint repository</td>
<td>19</td>
</tr>
<tr>
<td>Creating the Cognos Business Viewpoint repository in IBM DB2 for Windows, Linux, and UNIX</td>
<td>19</td>
</tr>
<tr>
<td>Creating the Cognos Business Viewpoint repository in Microsoft SQL Server</td>
<td>20</td>
</tr>
<tr>
<td>Creating the Cognos Business Viewpoint repository in Oracle</td>
<td>21</td>
</tr>
<tr>
<td>Configuring web browsers</td>
<td>23</td>
</tr>
<tr>
<td><strong>Chapter 7. Installing and configuring IBM Cognos Business Viewpoint Server</strong></td>
<td>25</td>
</tr>
<tr>
<td>Setting your JAVA_HOME variable</td>
<td>25</td>
</tr>
<tr>
<td>Installing Cognos Business Viewpoint Server on Windows</td>
<td>25</td>
</tr>
<tr>
<td>Installing Cognos Business Viewpoint Server on Linux and UNIX</td>
<td>26</td>
</tr>
<tr>
<td>Configuring Cognos Business Viewpoint Server</td>
<td>27</td>
</tr>
<tr>
<td>Specifying a connection to a mail server account</td>
<td>29</td>
</tr>
<tr>
<td>Testing the Cognos Business Viewpoint Server configuration</td>
<td>29</td>
</tr>
<tr>
<td>Creating a data source in the IBM Cognos Business Intelligence environment</td>
<td>30</td>
</tr>
<tr>
<td>Configuring IBM Cognos Software Development Kit to run Cognos Business Viewpoint tasks</td>
<td>31</td>
</tr>
<tr>
<td><strong>Chapter 8. Configuring IBM Cognos Business Viewpoint Server to use an authentication provider</strong></td>
<td>33</td>
</tr>
<tr>
<td>Configuring IBM Cognos Business Viewpoint Server to use Active Directory Server</td>
<td>33</td>
</tr>
<tr>
<td>Configuring an Active Directory namespace</td>
<td>34</td>
</tr>
<tr>
<td>Including or excluding domains by using advanced properties</td>
<td>34</td>
</tr>
<tr>
<td>Configuring IBM Cognos Business Viewpoint Server to use LDAP</td>
<td>35</td>
</tr>
<tr>
<td>Configuring an LDAP namespace</td>
<td>36</td>
</tr>
<tr>
<td>Configuring an LDAP namespace for Active Directory Server</td>
<td>37</td>
</tr>
<tr>
<td>Replace Operation</td>
<td>39</td>
</tr>
<tr>
<td>Configuring IBM Cognos Business Viewpoint Server to use an NTLM namespace</td>
<td>39</td>
</tr>
<tr>
<td>Configuring an NTLM namespace</td>
<td>39</td>
</tr>
<tr>
<td>Testing the namespaces</td>
<td>40</td>
</tr>
<tr>
<td>Delete an Authentication Provider</td>
<td>40</td>
</tr>
<tr>
<td><strong>Chapter 9. Configuring IBM Cognos Business Viewpoint Server for IBM WebSphere Application Server</strong></td>
<td>43</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Creating a separate JVM instance</td>
<td>43</td>
</tr>
<tr>
<td>Checking the setup of IBM Cognos Business Viewpoint</td>
<td>43</td>
</tr>
<tr>
<td>Backing up the existing IBM Cognos Business Viewpoint configuration</td>
<td>44</td>
</tr>
<tr>
<td>Setting environment variables</td>
<td>45</td>
</tr>
<tr>
<td>Configuring IBM Cognos Business Viewpoint to run within WebSphere Application Server</td>
<td>46</td>
</tr>
<tr>
<td>Building the IBM Cognos Business Viewpoint application file</td>
<td>46</td>
</tr>
<tr>
<td>Deploy the IBM Cognos Business Viewpoint application</td>
<td>47</td>
</tr>
<tr>
<td>Chapter 10. Maintaining IBM Cognos Business Viewpoint</td>
<td>49</td>
</tr>
<tr>
<td>Optimizing IBM Cognos Business Viewpoint</td>
<td>49</td>
</tr>
<tr>
<td>Backing up and restoring data</td>
<td>49</td>
</tr>
<tr>
<td>- Backing up and restoring the Cognos Business Viewpoint repository using database tools</td>
<td>50</td>
</tr>
<tr>
<td>- Backing up the Business Viewpoint data using Business Viewpoint Studio</td>
<td>50</td>
</tr>
<tr>
<td>- Restoring the Business Viewpoint data using Business Viewpoint Studio</td>
<td>51</td>
</tr>
<tr>
<td>Uninstalling IBM Cognos Business Viewpoint Server</td>
<td>52</td>
</tr>
<tr>
<td>- Uninstall Cognos Business Viewpoint Server on Windows operating systems</td>
<td>53</td>
</tr>
<tr>
<td>- Uninstall Cognos Business Viewpoint Server on UNIX or Linux</td>
<td>53</td>
</tr>
<tr>
<td>Appendix A. Install the IBM Cognos Business Intelligence Samples</td>
<td>55</td>
</tr>
<tr>
<td>Setting Up the Samples</td>
<td>55</td>
</tr>
<tr>
<td>- Restoring Backup Files for the Samples Databases</td>
<td>56</td>
</tr>
<tr>
<td>- Restore Backup Files for Sample Databases for DB2 Using Scripts</td>
<td>58</td>
</tr>
<tr>
<td>- Restore Backup Files for Sample Databases for Oracle Using Scripts</td>
<td>62</td>
</tr>
<tr>
<td>- Set Up the TM1 Samples</td>
<td>65</td>
</tr>
<tr>
<td>Samples Overview</td>
<td>67</td>
</tr>
<tr>
<td>- The Sample Outdoors Group of Companies</td>
<td>67</td>
</tr>
<tr>
<td>- Employees</td>
<td>68</td>
</tr>
<tr>
<td>- Sales and Marketing</td>
<td>69</td>
</tr>
<tr>
<td>Appendix B. Setting up an unattended installation and configuration</td>
<td>71</td>
</tr>
<tr>
<td>Setting up an unattended installation</td>
<td>71</td>
</tr>
<tr>
<td>- Using a file generated by an installation on another computer</td>
<td>71</td>
</tr>
<tr>
<td>- Using the response.ats file</td>
<td>72</td>
</tr>
<tr>
<td>Setting up an unattended configuration</td>
<td>73</td>
</tr>
<tr>
<td>Setting up an unattended uninstallation</td>
<td>74</td>
</tr>
<tr>
<td>Appendix C. Troubleshooting</td>
<td>77</td>
</tr>
<tr>
<td>Log files</td>
<td>77</td>
</tr>
<tr>
<td>Cannot initialize a DB2 database</td>
<td>79</td>
</tr>
<tr>
<td>Cannot initialize the SQL Server database</td>
<td>79</td>
</tr>
<tr>
<td>Cannot initialize a database that was configured using SQL Express</td>
<td>80</td>
</tr>
<tr>
<td>Unable to read the contents of the keystore</td>
<td>80</td>
</tr>
<tr>
<td>Java out-of-memory exceptions</td>
<td>81</td>
</tr>
<tr>
<td>Performance issues with an Oracle database</td>
<td>81</td>
</tr>
<tr>
<td>IBM Cognos Business Viewpoint Service is not connected to the database on the same computer</td>
<td>82</td>
</tr>
<tr>
<td>IBM Cognos Business Viewpoint Service does not start because a Windows Service is still running</td>
<td>82</td>
</tr>
<tr>
<td>Appendix D. Keyboard Shortcuts for the Installation Wizard</td>
<td>85</td>
</tr>
<tr>
<td>Notices</td>
<td>87</td>
</tr>
<tr>
<td>Index</td>
<td>91</td>
</tr>
</tbody>
</table>
Introduction

IBM® Cognos® Business Viewpoint allows business and financial analysts the ability to maintain, govern, and share the dimensions and hierarchies that the business uses to drive performance.

This document includes the information that you need to install Cognos Business Viewpoint Server.

Audience

This document is intended to help system administrators and information technology specialists install Cognos Business Viewpoint Server.

Finding information

To find IBM Cognos product documentation on the web, including all translated documentation, access the IBM Cognos Business Viewpoint 10.1 information center at [http://publib.boulder.ibm.com/infocenter/cbv/v10r1m0/index.jsp](http://publib.boulder.ibm.com/infocenter/cbv/v10r1m0/index.jsp). Updates to Release Notes are published directly to Information Centers.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility Features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. The installation wizard has accessibility features. For information on these features, see Appendix D, “Keyboard Shortcuts for the Installation Wizard,” on page 85.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 1. Components used by IBM Cognos Business Viewpoint Server

Cognos Business Viewpoint Server renders the IBM Cognos Business Viewpoint Studio interface. Cognos Business Viewpoint Server runs requests to the database and connects to other IBM Cognos components. Cognos Business Viewpoint Studio is a web-based tool that gives business and financial analysts the ability to create, maintain, govern, and share the dimensions and hierarchies that the business uses to drive performance.

You can leverage the security that is already configured in an existing IBM Cognos environment and apply it to Cognos Business Viewpoint Server.

Components installed with IBM Cognos Business Viewpoint Server

The following components are installed automatically when you install Cognos Business Viewpoint Server.

**Tomcat Application Server**

Apache Tomcat is the application server that Cognos Business Viewpoint Server uses to serve dynamic content. Tomcat is also a web server that serves static web content; because of this, a separate web server component is not installed with Cognos Business Viewpoint Server. You can choose to run Cognos Business Viewpoint within IBM WebSphere® Application Server instead.

**Cognos Business Viewpoint Server**

Cognos Business Viewpoint Server renders the IBM Cognos Business Viewpoint Studio interface. It runs requests to the database and connects to other IBM Cognos components.

**IBM Cognos Configuration**

IBM Cognos Configuration configures Cognos Business Viewpoint. It also allows you to start and stop its services.

**IBM Cognos Business Viewpoint Studio**

Cognos Business Viewpoint Studio is a web-based tool that business and financial analysts use to create, maintain, govern, and share the dimensions and hierarchies that the business uses to drive performance.

Components not installed with IBM Cognos Business Viewpoint Server

The following components are not installed when you install Cognos Business Viewpoint Server.

**IBM Cognos Connection**

IBM Cognos Connection is a web portal provided with IBM Cognos Business Intelligence (BI). It provides a single point of entry for querying, analyzing, and
organizing data, and for creating reports, scorecards, and events. Users can run all their web-based IBM Cognos applications through IBM Cognos Connection. IBM Cognos Connection can integrate other business intelligence applications and URLs to other applications.

IBM Cognos BI can be configured to allow Cognos Business Viewpoint Studio users to publish packages to IBM Cognos Connection.

**IBM Cognos Business Viewpoint Client**

Using Cognos Business Viewpoint Client, business users can transfer data between Cognos Business Viewpoint Studio and other applications, such as IBM Cognos Planning - Analyst or IBM Cognos TM1®.

For more information, see the *Cognos Business Viewpoint Client Installation and Configuration Guide*.

**IBM Cognos Business Viewpoint for Microsoft Excel**

Cognos Business Viewpoint for Microsoft Excel lets you download data from Cognos Business Viewpoint Studio to Microsoft Excel, manipulate the data, and then return it to Cognos Business Viewpoint Studio.

For more information, see the *Cognos Business Viewpoint for Microsoft Excel Installation and Configuration Guide*.

**IBM Cognos Data Manager Runtime**

Cognos Data Manager Runtime allows you to move data between products. For example, to move fact data to IBM Cognos TM1 or to source data from other IBM Cognos packages.

For more information, see [Chapter 5, “Installation requirements to move fact data into IBM Cognos TM1,” on page 15](#).

If you already have a supported version of Data Manager, you can use that version. If not, use the Data Manager Runtime installer that is provided with Business Viewpoint.
Chapter 2. Installation and testing checklist for Cognos Business Viewpoint

Use the following checklist to ensure that you install and test the Cognos Business Viewpoint features that you want to deploy.

If you are already using Cognos Business Viewpoint and want to update your existing Cognos Business Viewpoint environment, review the information in Chapter 3, “Upgrading Cognos Business Viewpoint,” on page 5 instead of this checklist.

Procedure

1. Prepare for implementation.
   This task is usually performed by a team that is assembled and led by the performance management solutions architect. Cognos Business Viewpoint implementation will install and configure it to integrate effectively with your existing infrastructure. To ensure that Cognos Business Viewpoint is implemented effectively, do the following steps:
   - Consider your distribution options. For more information, see Chapter 4, “Distribution options for IBM Cognos Business Viewpoint Server,” on page 11.
   - Set up your environment. This involves reviewing the release notes, supported environments, verifying the system requirements, and setting up your database. For more information, see Chapter 6, “Setting up your environment,” on page 17.

2. Install and configure Cognos Business Viewpoint Server.
   This task is usually performed by a system administrator or information technology consultant. You can install the server software in one of two ways:
   - You can run the installation wizard, choosing options as you go. For more information, see “Installing Cognos Business Viewpoint Server on Windows” on page 25 or “Installing Cognos Business Viewpoint Server on Linux and UNIX” on page 26.
   - You can set up and run an unattended installation. This non-interactive method of installing and configuring Cognos Business Viewpoint Server has all the tasks run automatically. You can run the unattended installation as part of a script, or from the command line. For more information, see Appendix B, “Setting up an unattended installation and configuration,” on page 71.

3. Optional: Create a data source in the Business Intelligence environment.
   This enables publishing packages from Cognos Business Viewpoint to IBM Cognos BI. For more information, see “Creating a data source in the IBM Cognos Business Intelligence environment” on page 30.

4. Optional: Test that a Cognos Business Viewpoint Studio user can publish packages to Cognos BI.
   For more information, see the Cognos Business Viewpoint Studio User Guide.

5. Optional: Configure IBM Cognos Software Development Kit to run Cognos Business Viewpoint tasks.
You can enable Cognos Software Development Kit users to create scripts that run Cognos Business Viewpoint tasks automatically. For more information, see “Configuring IBM Cognos Software Development Kit to run Cognos Business Viewpoint tasks” on page 31.

6. Optional: Test that the Cognos BI Software Development Kit configuration was successful.
   For more information, see the Cognos Software Development Kit Developer Guide.

7. Set up and maintain security.
   You can either use the authentication that is configured in an existing Business Intelligence environment, or you can use Cognos Access Manager (CAM) that is included on the Cognos Business Viewpoint installation CD.
   To set up security in Cognos Business Viewpoint, use Cognos Business Viewpoint Studio to change the credentials for the "admin" user, specify the system on which users are authenticated, and create and manage both Cognos Business Viewpoint users and external users. For more information, see the Cognos Business Viewpoint Studio User Guide.

8. Test that you successfully set up security.
   For more information, see the Cognos Business Viewpoint Studio User Guide.

   Cognos Business Viewpoint Client enables external Cognos applications to interoperate with Cognos Business Viewpoint Studio. For installation information, see the Cognos Business Viewpoint Client Installation and Configuration Guide.

10. Test the configuration of Cognos Business Viewpoint Client.
    To test that the configuration was successful, see the Cognos Business Viewpoint Client Installation and Configuration Guide.

    Cognos Business Viewpoint for Microsoft Excel lets you download data from Cognos Business Viewpoint Studio to Microsoft Excel, manipulate the data, and then return it to Cognos Business Viewpoint Studio. For installation and configuration information, see the Cognos Business Viewpoint for Microsoft Excel Installation and Configuration Guide.

    For more information, see the Cognos Business Viewpoint for Microsoft Excel Installation and Configuration Guide.

13. Optional: Install and setup samples databases.
    Use the IBM Cognos Business Intelligence samples to experiment with Business Viewpoint features and for troubleshooting. For more information, see Appendix A, “Install the IBM Cognos Business Intelligence Samples,” on page 55.
Chapter 3. Upgrading Cognos Business Viewpoint

New versions of Cognos Business Viewpoint provide enhancements that might affect existing Cognos Business Viewpoint components. Administrators can move data from an earlier version of Cognos Business Viewpoint to the latest version.

To upgrade your existing Cognos Business Viewpoint environment, you must perform the following tasks:
1. Upgrade Cognos Business Viewpoint Server, which includes creating and using a new Cognos Business Viewpoint repository.
2. Upgrade Cognos Business Viewpoint Client.

Before you begin
1. Review the Release Notes for late-breaking issues, the list of environments that are supported by IBM Cognos products, as well as the minimum hardware and software requirements to install and run Cognos Business Viewpoint Server. For more information, see “Reviewing software and hardware requirements for Cognos Business Viewpoint Server” on page 17.
2. Ensure that there is a recent database backup of your Cognos Business Viewpoint repository. For more information, see “Backing up and restoring the Cognos Business Viewpoint repository using database tools” on page 50.
3. If you want to keep the same Cognos Business Viewpoint settings in the latest version, start IBM Cognos Configuration on the Cognos Business Viewpoint Server and record the current Cognos Business Viewpoint settings that you want to reuse for the environment, security, and notification parameters. The following table shows a subset of the values that you might want to save.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Sample value</th>
<th>Your value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment setting: Tomcat Server HTTP port number</td>
<td>9410</td>
<td></td>
</tr>
<tr>
<td>Environment setting: Tomcat Server SSL HTTP/1.1 port number</td>
<td>9443</td>
<td></td>
</tr>
<tr>
<td>Data access notification setting: SMTP mail server</td>
<td>mailserver:25</td>
<td></td>
</tr>
</tbody>
</table>

4. Cognos Business Viewpoint Client subscription information is stored in the Cognos Business Viewpoint repository. To maintain your existing Cognos Business Viewpoint Client subscriptions, start IBM Cognos Configuration on each computer where Cognos Business Viewpoint Client is installed and record the configuration information for each of the adapters that you want to recreate. The following table shows a subset of the values that you might want to save.
5. Create a new database for the Cognos Business Viewpoint repository. For more information, see “Creating the IBM Cognos Business Viewpoint repository” on page 19.

6. When migrating data, follow these steps to ensure that no one uses Cognos Business Viewpoint during the migration:
   a. Stop the Cognos Business Viewpoint service.
   b. Change the application server port number for Cognos Business Viewpoint to a value that users will not access during the migration process. Use this port number when using Cognos Business Viewpoint Studio to create the Cognos Business Viewpoint backup.
   c. Restart the Cognos Business Viewpoint service.

### Upgrading Cognos Business Viewpoint 8.4

#### Before you begin


#### About this task

To upgrade from Cognos Business Viewpoint 8.4, you must first use Cognos Business Viewpoint 8.4.1 to migrate the Cognos Business Viewpoint Version 8.4 data. Then, you use the latest Cognos Business Viewpoint version to restore the backup file that was created using Cognos Business Viewpoint Version 8.4.1.

Use the following procedure:

#### Procedure

1. Install Cognos Business Viewpoint 8.4.1.

2. From Cognos Business Viewpoint Studio 8.4.1, use the migrate feature to create a backup of the Cognos Business Viewpoint 8.4 data. For information, see the “Upgrading data from an earlier version of Business Viewpoint” topic in the IBM Cognos Business Viewpoint Studio User Guide 8.4.1.

   **Important:** Keep track of the password associated with this backup file, as well as the administrator user login information associated with it. This information is required when you restore the file. The following table shows the values that you want to record.

#### Table 3. Cognos Business Viewpoint backup file information

<table>
<thead>
<tr>
<th>Backup file information</th>
<th>Sample value</th>
<th>Your value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password used to encrypt the backup file</td>
<td>Backup2011</td>
<td></td>
</tr>
</tbody>
</table>
### Table 3. Cognos Business Viewpoint backup file information (continued)

<table>
<thead>
<tr>
<th>Backup file information</th>
<th>Sample value</th>
<th>Your value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name (optionally, record the password if using the “admin” user name and the password was changed)</td>
<td>admin</td>
<td></td>
</tr>
</tbody>
</table>

The backup files are saved on the server where Cognos Business Viewpoint Server is installed in the `install_location/migration` directory, where `install_location` represents the Cognos Business Viewpoint Server installation path.

3. Log out from Cognos Business Viewpoint Studio.
4. Stop the Cognos Business Viewpoint service.
6. Configure the Cognos Business Viewpoint Server using the values that you previously recorded or by specifying new values. For more information, see “Configuring Cognos Business Viewpoint Server” on page 27.

**Important:** The Cognos Business Viewpoint Server must point to the new Cognos Business Viewpoint repository.

7. Start the Cognos Business Viewpoint Server service.
8. Copy the Cognos Business Viewpoint 8.4.1 backup file into the `install_location/migration` directory of the current version of the Cognos Business Viewpoint installation.
9. Log in to the current version of Cognos Business Viewpoint Studio using the Cognos Business Viewpoint Administrator account user name (admin) and password (admin).

**Important:** You must use the “admin” user name because the Cognos Business Viewpoint repository is empty. The user “admin” is the only Cognos Business Viewpoint Studio user that does not require an association with an account from an external namespace.

10. From Cognos Business Viewpoint Studio, restore the Cognos Business Viewpoint backup file:
   a. Click **Tools > Administration**.
   b. Click the **Backup and Restore** tab.
   c. Select the backup file to restore and click **Restore Backup**.
   d. Enter the password that was specified to encrypt the backup file.
   e. Click **OK**.
   f. After the data is restored, you are required to login again.

   **Important:** The user name must exist in the backup file.

### What to do next

1. Install the current version of the Cognos Business Viewpoint Client on any computer that connects to this Cognos Business Viewpoint Server. For more information, see the Cognos Business Viewpoint Client Installation and Configuration Guide.
2. Re-create the Cognos Business Viewpoint Client adapters using the information that you previously recorded or configure new ones. For more information, see Cognos Business Viewpoint Client Installation and Configuration Guide.

3. If you previously published Cognos Business Viewpoint information as IBM Cognos packages, you must update your BusinessViewpoint data source connection to point to the new Cognos Business Viewpoint repository. Then, you must republish the packages in the new version of Cognos Business Viewpoint.

Related information

- Upgrading data from an earlier version of Business Viewpoint

Upgrading Cognos Business Viewpoint 8.4.1 or a later version

Before you begin


Procedure

1. In Cognos Business Viewpoint Studio, create a Cognos Business Viewpoint backup file of your current Cognos Business Viewpoint data:
   a. Click Tools > Administration.
   b. Click the Backup and Restore tab.
   c. Click New Backup and type a name for the backup file and create a password so that the file is encrypted.

   **Important:** Keep track of the password associated with this backup file, as well as the administrator user login information associated with it. This information is required when you restore the file. The following table shows the values that you want to record.

<table>
<thead>
<tr>
<th>Backup file information</th>
<th>Sample value</th>
<th>Your value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password used to encrypt the backup file</td>
<td>Backup2011</td>
<td></td>
</tr>
<tr>
<td>User name (optionally, record the password if using the “admin” user name and the password was changed)</td>
<td>admin</td>
<td></td>
</tr>
</tbody>
</table>

   The backup files are saved on the server where Cognos Business Viewpoint Server is installed in the `install_location/migration` directory, where `install_location` represents the Cognos Business Viewpoint Server installation path.
   d. Click OK.
   e. Click Close.
2. Log out from Cognos Business Viewpoint Studio.
3. Stop the Cognos Business Viewpoint service.
5. Configure the Cognos Business Viewpoint Server using the values that you previously recorded or by specifying new values. For more information, see "Configuring Cognos Business Viewpoint Server" on page 27.

**Important:** The Cognos Business Viewpoint Server must point to the new Cognos Business Viewpoint repository.


7. Log in the current version of Cognos Business Viewpoint Studio using the Cognos Business Viewpoint Administrator account user name (admin) and password (admin).

**Important:** You must use the “admin” user name because the Cognos Business Viewpoint repository is empty. The user “admin” is the only Cognos Business Viewpoint Studio user that does not require an association with an account from an external namespace.

8. Copy the Cognos Business Viewpoint backup file that you created for the earlier version of Cognos Business Viewpoint into the `install_location/migration` directory of the current version of the Cognos Business Viewpoint installation.

9. From Cognos Business Viewpoint Studio, restore the Cognos Business Viewpoint backup file:
   a. Click **Tools** > **Administration**.
   b. Click the **Backup and Restore** tab.
   c. Select the backup file to restore and click **Restore Backup**.
   d. Enter the password that was specified to encrypt the backup file.
   e. Click **OK**.
   f. After the data is restored, you are required to login again.

**Important:** The user name must exist in the backup file.

**What to do next**

1. Install the current version of the Cognos Business Viewpoint Client on any computer that connects to this Cognos Business Viewpoint Server. For more information, see the Cognos Business Viewpoint Client Installation and Configuration Guide.

2. Re-create the Cognos Business Viewpoint Client adapters using the information that you previously recorded or configure new ones. For more information, see Cognos Business Viewpoint Client Installation and Configuration Guide.

3. If you previously published Cognos Business Viewpoint information as IBM Cognos packages, you must update your `BusinessViewpoint` data source connection to point to the new Cognos Business Viewpoint repository. Then, you must republish the packages in the new version of Cognos Business Viewpoint.
Chapter 4. Distribution options for IBM Cognos Business Viewpoint Server

All Cognos Business Viewpoint Server components are installed on one computer. You can distribute Cognos Business Viewpoint Server in multiple ways.

You can setup Business Viewpoint Server in the following configurations:
- Install and configure Cognos Business Viewpoint Server and the database server on one computer.
  Use this option for a demonstration or in a proof of concept environment.
- Install and configure Cognos Business Viewpoint Server and the database server on separate computers.
  Use this option when a different functional group manages the database server.
- Choose one of the first two configuration options, then configure an existing IBM Cognos Business Intelligence (BI) server to setup a data source connection to the Cognos Business Viewpoint database.
  Use this option if Cognos Business Viewpoint users want to publish packages to an Cognos BI server, import packages from Cognos BI, or add external users to Cognos Business Viewpoint Studio.

IBM Cognos Business Viewpoint Server and database server on one computer

You can install Cognos Business Viewpoint Server and the database server on one computer. Choose this scenario for proof of concept or demonstration environments where the user load is small.

In the following diagrams, one installation shows the Cognos Business Viewpoint Client, Cognos Business Viewpoint Server, the Tomcat or Websphere application server, and the database server containing the Cognos Business Viewpoint repository all on one computer. The other installation shows the Cognos Business Viewpoint Client installed on a separate computer.
Configuration requirements

If you install Cognos Business Viewpoint Server and the database on the same computer, you must then do the following:

- Specify connection information, including the server name, to the Cognos Business Viewpoint repository.
- Configure a mail server to send notifications (if required). For more information, see “Specifying a connection to a mail server account” on page 29.

IBM Cognos Business Viewpoint Server and database server on separate computers

The Cognos Business Viewpoint repository can reside on the same computer as Cognos Business Viewpoint Server or on a different one.

If you install the database on a different computer than Cognos Business Viewpoint Server, you free up processing power Cognos Business Viewpoint Server can use. This also allows a different functional group to manage the database server.

In the following diagram, Cognos Business Viewpoint Server and the Tomcat or Websphere application server are installed on one computer and the database is installed on a second computer.

Configuration requirements

If you install Cognos Business Viewpoint Server and the database on separate computers, you must then do the following:

- Specify connection information, including the server name, to the Cognos Business Viewpoint repository.
- Configure a mail server to send notifications (if required). For more information, see “Specifying a connection to a mail server account” on page 29.
Integration with IBM Cognos Business Intelligence

IBM Cognos Business Viewpoint allows business users to share and manage dimensional data between different IBM Cognos products, such as IBM Cognos BI. You can integrate your Cognos Business Viewpoint environment with an Cognos BI environment by doing the following:

- Enabling the importing and publishing of packages
- Applying IBM Cognos security

Enabling the importing and publishing of packages

You can allow Cognos Business Viewpoint users to both import packages from, and publish packages to a Cognos BI environment. You do this by configuring the Business Intelligence server to connect to the Cognos Business Viewpoint database. For information, see “Creating a data source in the IBM Cognos Business Intelligence environment” on page 30.

Applying IBM Cognos security

You can use Cognos BI security to authenticate Cognos Business Viewpoint users.

For more information about Cognos Business Viewpoint administrative tasks, see the Cognos Business Viewpoint Studio User Guide.

Integrating with other IBM products

You can also integrate your Cognos Business Viewpoint environment with several other IBM products, such as IBM Cognos Planning - Analyst and IBM InfoSphere™ Master Data Management Server, as well as csv files and relational data sources.

For more information, see the Cognos Business Viewpoint Client Installation and Configuration Guide.
Chapter 5. Installation requirements to move fact data into IBM Cognos TM1

In IBM Cognos Business Viewpoint, you can move fact data into IBM Cognos TM1 from a number of external data applications, including other Cognos TM1 servers. This capability allows users to easily bring in information that is critical to being able to fully define their business view for planning and analysis.

To be able to move fact data into Cognos TM1, you must have the following versions of software installed:

- At a minimum, you must have Cognos TM1 version 9.4.1 with Fix Pack 3 and hotsite 5.
- On Windows operating systems, the Cognos TM1 client must be installed on the same computer as Cognos Business Viewpoint Server.

To be able to source data from IBM Cognos packages, you must have the following versions of software installed:

- At a minimum, you must have IBM Cognos BI version 8.4.1 with Fix Pack 2.
- A version of IBM Cognos Data Manager that is compatible with your installation of Cognos BI. Cognos Data Manager must be a minimum of version 8.4.1 with Fix Pack 2. Also, install any available hotsite updates.
  - Cognos Data Manager must be installed in the same location as your Cognos BI servers.
  - Cognos Data Manager version 8.4.1 can be installed only on Windows operating systems. Cognos Data Manager version 10.1 or later can be installed on AIX®, Solaris or Windows operating systems.
  - On Windows operating systems, the Cognos TM1 client must be installed on the same computer as you have Cognos Data Manager installed.

You must have Cognos Business Viewpoint Server and the Cognos Data Manager Runtime component installed on computers running the Windows operating system.

If you already have a supported version of Cognos Data Manager, you can use that version. If not, use the Cognos Data Manager Runtime installer that is provided with Cognos Business Viewpoint.

**Note:** While you can have a different version of the Cognos TM1 client than you have of the Cognos TM1 server, the Cognos TM1 client must be the same or an earlier version than you have of the Cognos TM1 server. You cannot use a later version of the Cognos TM1 client than you have of the Cognos TM1 server to use it with Cognos Business Viewpoint.

**Configuration requirements**

To use Cognos Business Viewpoint with Cognos TM1, you must install the Cognos TM1 client on the computers with your other components.

In the following diagram, the Cognos TM1 client is installed on the computer with Cognos Business Viewpoint Server and on the computer with Cognos BI and
Cognos Data Manager.
Chapter 6. Setting up your environment

Before you install or upgrade IBM Cognos Business Viewpoint Server, you must review system requirements and set up resources in your environment.

**Procedure**

1. Review the release notes for late-breaking issues, the list of environments that are supported by IBM Cognos products, as well as the minimum hardware and software requirements to install and run Cognos Business Viewpoint Server. For more information, see “Reviewing software and hardware requirements for Cognos Business Viewpoint Server.”

2. Create a relational database for Cognos Business Viewpoint Server to use as a repository. For more information, see “Creating the IBM Cognos Business Viewpoint repository” on page 19.

3. Configure the web browsers. For more information, see “Configuring web browsers” on page 23.

**Reviewing software and hardware requirements for Cognos Business Viewpoint Server**

Review the minimum hardware and prerequisite software requirements to ensure that your product works properly. Apply all of the minimum required operating system patches and use only the supported versions of other software with Cognos Business Viewpoint.

**Before you begin**

Review the latest list of environments supported by IBM Cognos products, including information on operating systems, patches, and browsers, by visiting the IBM Cognos Resource Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).


**Procedure**

1. Ensure that your system meets the minimum hardware requirements described in the following table. You might require additional resources for distributed or production environments.
Table 5. Minimum hardware requirements for Cognos Business Viewpoint Server

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td></td>
<td>UNIX</td>
</tr>
<tr>
<td></td>
<td>Linux</td>
</tr>
<tr>
<td><strong>Note:</strong> There are many available versions of the Linux operating system that support many hardware platforms. Ensure that the IBM Cognos products support the operating system and hardware combination that you are using.</td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 2 GB</td>
</tr>
<tr>
<td>Operating system specifications</td>
<td>File descriptor limit set to 2048 on UNIX and Linux</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 2.5 GB of free space is required to install the software and 4 GB of free space is required on the drive that contains the temporary directory used by IBM Cognos components.</td>
</tr>
<tr>
<td></td>
<td>For all databases, the size will increase over time. Ensure that you have sufficient disk space for future requirements.</td>
</tr>
</tbody>
</table>

2. Ensure that your system meets the minimum software requirements described in the following table to install and run Cognos Business Viewpoint Server.

Table 6. Minimum software requirements for Cognos Business Viewpoint Server

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Runtime Environment (JRE)</td>
<td>An IBM JRE is installed automatically with Cognos Business Viewpoint Client on Windows operating systems.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> If you choose to use a different JRE, the version must be 1.5.0 or higher.</td>
</tr>
<tr>
<td>Database</td>
<td>You must have one of the minimum supported versions of the following databases available to store Cognos Business Viewpoint data:</td>
</tr>
<tr>
<td></td>
<td>* IBM DB2® for Windows, Linux, and UNIX</td>
</tr>
<tr>
<td></td>
<td>* Oracle</td>
</tr>
<tr>
<td></td>
<td>* Microsoft SQL Server</td>
</tr>
<tr>
<td></td>
<td>TCP/IP connectivity is required for all database types.</td>
</tr>
</tbody>
</table>
Table 6. Minimum software requirements for Cognos Business Viewpoint Server (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser</td>
<td>For all web browsers, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>• cookies</td>
</tr>
<tr>
<td></td>
<td>• JavaScript</td>
</tr>
<tr>
<td></td>
<td>For Microsoft Internet Explorer only, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>• Run ActiveX controls and plug-ins</td>
</tr>
<tr>
<td></td>
<td>• Script ActiveX controls marked safe for scripting</td>
</tr>
<tr>
<td></td>
<td>• Active scripting</td>
</tr>
</tbody>
</table>

3. Review the list of optional software requirements in the following table.

Table 7. Optional software requirements for Cognos Business Viewpoint Server

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server</td>
<td>By default, Tomcat is installed as the application server during installation.</td>
</tr>
<tr>
<td></td>
<td>You can use IBM WebSphere Application Server instead.</td>
</tr>
<tr>
<td>Authentication provider</td>
<td>By default, anonymous access is enabled.</td>
</tr>
<tr>
<td></td>
<td>Cognos Business Viewpoint Server supports the following types of servers as authentication providers:</td>
</tr>
<tr>
<td></td>
<td>• Active Directory Server</td>
</tr>
<tr>
<td></td>
<td>• LDAP</td>
</tr>
<tr>
<td></td>
<td>• NTLM namespace</td>
</tr>
<tr>
<td>Mail server</td>
<td>To send reports using email.</td>
</tr>
</tbody>
</table>

Creating the IBM Cognos Business Viewpoint repository

The Cognos Business Viewpoint repository is a relational database that Cognos Business Viewpoint uses to store data.

Creating the Cognos Business Viewpoint repository in IBM DB2 for Windows, Linux, and UNIX

When you create a database in IBM DB2 for Windows, Linux, and UNIX for the IBM Cognos Business Viewpoint repository, you must use specific configuration settings.

Procedure

1. Create a database user account on your operating system and name it DMADMIN. Specify that the user password never expires.

   **Important:** If the database user account is not named DMADMIN, the Cognos Business Viewpoint Server configuration will fail.

2. Add DMADMIN to the DB2ADMNS and DB2USERS groups.

3. Create the Cognos Business Viewpoint database. You can use most of the default settings, however, change the following settings:
a. Set the database name. In the examples in this book, the database name is BVSDB.

   **Important:** You must use the same database name in IBM Cognos Configuration when you configure Cognos Business Viewpoint Server. For more information, see “Configuring Cognos Business Viewpoint Server” on page 27.

b. Change the default page size for the buffer pools and table space page size to 32K.

4. Confirm that the database uses UTF-8 as the code set value and 1208 as the code page. These values are usually the default values when creating a DB2 database and are the required settings.

   To check your database settings, type the following command using a DB2 command prompt:
   ```
   db2 get database configuration for <database_name>.
   ```

   If the values do not match, recreate the database.

5. Create additional table spaces for the database:
   - A regular or large table space for the data. For example, BVS_TS_DATA.
   - A user temporary table space. For example, BVS_TS_USER_TEMP.
   - A system temporary table space. For example, BVS_TS_SYS_TEMP.

6. Update the following database configuration parameters:
   - Set the size of log files (`logfilsiz`) to 4096.
   - Set the number of primary log files (`logprimary`) to 20.
   - Set the application heap size (`applheapsz`) to 1024. If the application heap size value is too small, out of memory errors might occur when there are many users.
   - Set the application lock timeout (`locktimeout`) value to 240 seconds.

   **Important:** These settings are suggested initial values and should be adjusted to meet your environment and performance requirements.

7. Add a schema called DMADMIN to the database and associate it with the DMADMIN user.

   **Important:** If the schema is not named DMADMIN, the Cognos Business Viewpoint Server configuration will fail.

8. Update the user DMADMIN in the new database and grant all authorities to the user. Ensure that DMADMIN has the following privileges:
   - CREATEIN
   - DROPIN
   - ALTERIN

**What to do next**

The database administrator must back up the Cognos Business Viewpoint repository regularly because it contains the IBM Cognos data. To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

**Creating the Cognos Business Viewpoint repository in Microsoft SQL Server**

When you create a Microsoft SQL Server database for the IBM Cognos Business Viewpoint repository, you must use specific configuration settings.
**Procedure**

1. Ensure that the collation sequence is not case sensitive and that the SQL Server is configured for mixed mode authentication. The Cognos Business Viewpoint Server installation uses the locale identified by the collation of the installation program. You cannot change this setting later.

2. Enable TCP/IP network protocol.

3. Ensure that SQL Server uses a static port number.
   - Cognos Business Viewpoint Server uses a default SQL port number of 1433. If you set a different port number in SQL Server, you must set the same number in IBM Cognos Configuration when you configure Cognos Business Viewpoint Server. For more information, see “Configuring Cognos Business Viewpoint Server” on page 27.

4. Connect to the database engine as a user with administrator privileges.

5. Create the Cognos Business Viewpoint database and give it a name, for example, BVSDB: The database character encoding must be set to UTF-8 or UTF-16. In addition, specify the following values:
   - For the data file, specify a minimum initial size of 2000 MB.
   - For the log file, specify a minimum initial size of 200 MB.

   **Important:** These settings are suggested initial values and should be adjusted to meet your environment and performance requirements.
   - You must set the same name in IBM Cognos Configuration when you configure Cognos Business Viewpoint Server. For more information, see “Configuring Cognos Business Viewpoint Server” on page 27.

6. Create a SQL Server login name, for example BVSDB:

   **Important:** Specify that the login name uses authentication performed by the SQL Server, not by the Windows operating system.
   - Specify that the login password never expires.
   - Set the database that you created, for example BVSDB, as the default database.

7. Create a SQL Server user, for example BVSDB:
   - Specify that the new user is an owner of the db_owner schema.
   - Specify that the new user has the db_owner role.

8. Map the new login name to the user name that you created.

**What to do next**

The database administrator must back up the Cognos Business Viewpoint repository regularly because it contains the IBM Cognos data. To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

**Creating the Cognos Business Viewpoint repository in Oracle**

When you create an Oracle database for the IBM Cognos Business Viewpoint repository, you must use specific configuration settings.

**Before you begin**

The character encoding for the database must be AL32UTF8 or AL32UTF16.
Procedure

1. Configure the Oracle NLS parameters as shown in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLS_TIMESTAMP_FORMAT</td>
<td>DD-MON-RR HH.MM.SSFF AM</td>
</tr>
<tr>
<td>NLS_TIME_TZ_FORMAT</td>
<td>HH.MM.SSFF AM TZR</td>
</tr>
<tr>
<td>NLS_TIMESTAMP_TZ_FORMAT</td>
<td>DD-MON-RR HH.MM.SSFF AM TZR</td>
</tr>
<tr>
<td>NLS_DUAL_CURRENCY</td>
<td>$</td>
</tr>
<tr>
<td>NLS_NCHAR_CHARACTERSET</td>
<td>AL16UTF16</td>
</tr>
<tr>
<td>NLS_LENGTH_SEMANTICS</td>
<td>BYTE</td>
</tr>
<tr>
<td>NLS_NCHAR_CONV_EXCP</td>
<td>FALSE</td>
</tr>
<tr>
<td>NLS_COMP</td>
<td>BINARY</td>
</tr>
</tbody>
</table>

2. Connect to the database as an Administrator.

3. Create a data tablespace. For example, type the following command to create a
tablespace named BV_DATA_TS with a size of 4 GB:

   ```
   create tablespace BV_DATA_TS
   datafile '<datafile_path>/bv_data_ts.dbf'
   size 4g
   reuse;
   ```

4. Extend the tablespace to 4 GB+.

5. Create a database user and associate it with the tablespace. For example, to
create a user with the name BVUSER and a password of PASSWORD1, type the
following command:

   ```
   create user BVUSER identified by PASSWORD1
   default tablespace bv_data_ts
   temporary tablespace temp
   quota
   unlimited on bv_data_ts;
   ```

   **Note:** Specify the same name when you configure the database in IBM Cognos
Configuration.

   **Important:** These settings are suggested initial values and should be adjusted
to meet your environment and performance requirements.

6. Grant roles and privileges to the BVUSER user by typing the following
commands:

   ```
   grant connect, resource to BVUSER;
   grant create job to BVUSER;
   grant create view to BVUSER;
   grant create procedure to BVUSER;
   grant create trigger to BVUSER;
   grant create sequence to BVUSER;
   grant create synonym to BVUSER;
   ```

What to do next

The database administrator must back up the Cognos Business Viewpoint
repository regularly because it contains the IBM Cognos data. To ensure the
security and integrity of databases, protect them from unauthorized or
inappropriate access.
Configuring web browsers

Cognos Business Viewpoint uses the default browser configurations provided by Microsoft and Mozilla Firefox. For all browsers, ensure that they meet the minimum levels that are supported and that their settings are enabled for cookies and Java scripts. Additional required settings are specific to the browser.

In the web browsers, specify the settings shown in the following table.

*Table 9. Required web browsers setting for Cognos Business Viewpoint Studio*

<table>
<thead>
<tr>
<th>Browser</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer</td>
<td>Allow Cookies</td>
</tr>
<tr>
<td></td>
<td>Active Scripting</td>
</tr>
<tr>
<td></td>
<td>Allow META REFRESH</td>
</tr>
<tr>
<td>Firefox</td>
<td>Allow Cookies</td>
</tr>
<tr>
<td></td>
<td>Enable Java</td>
</tr>
<tr>
<td></td>
<td>Enable JavaScript</td>
</tr>
<tr>
<td></td>
<td>Load Images</td>
</tr>
</tbody>
</table>

Cognos Business Viewpoint Server uses the cookie JSESSIONID to store a unique user session identifier. The user session identifier is valid for the duration of the browser session.

After upgrading or installing new software, restart the web browser and advise users to clear their browser cache.
Chapter 7. Installing and configuring IBM Cognos Business Viewpoint Server

This section describes how to install, configure, and test Cognos Business Viewpoint Server. It also describes how to configure IBM Cognos Business Intelligence so that you can publish data from IBM Cognos Business Viewpoint Studio to Cognos Business Intelligence.

Do the following:

- If you want to use your own JRE or you are installing on UNIX, you must set your JAVA_HOME variable. For more information, see “Setting your JAVA_HOME variable.”
- Configure Cognos Business Viewpoint Server. For more information, see “Configuring Cognos Business Viewpoint Server” on page 27.
- Test the configuration to ensure that it is successful. For more information, see “Testing the Cognos Business Viewpoint Server configuration” on page 29.
- If you want to publish data from Cognos Business Viewpoint Studio to Cognos Business Intelligence, enable publishing data. For more information, see “Creating a data source in the IBM Cognos Business Intelligence environment” on page 30.
- If you want IBM Cognos Software Development Kit users to be able to automate Cognos Business Viewpoint tasks, update the configuration of the Cognos Business Intelligence environment. For more information, see “Configuring IBM Cognos Software Development Kit to run Cognos Business Viewpoint tasks” on page 31.

Setting your JAVA_HOME variable

Set a JAVA_HOME environment variable if one of the following applies to you:

- You are installing on the Microsoft Windows operating system and you want to use your own JRE but do not already have a JAVA_HOME variable set to that location.
- You are installing on the UNIX operating system.

Procedure

Ensure that the JAVA_HOME environment variable is set to the JRE location.

For example, to set JAVA_HOME to a JRE that you are already using, the path is java_location/bin/jre/version.

Installing Cognos Business Viewpoint Server on Windows

Before you install Cognos Business Viewpoint Server, ensure that you have created a server database that will be used by Cognos Business Viewpoint as the data repository.
Procedure
1. Insert the Cognos Business Viewpoint Server CD or go to the location where the installation files were downloaded and extracted.
2. Double-click `issetup.exe`.
3. On the Welcome page, click Next.
4. On the IBM License Agreement page, click I accept and click Next.
5. On the Installation Location page, accept or change the default location where Cognos Business Viewpoint Server will be installed and click Next.
   If an IBM Cognos product was already installed in the default location, you must choose a different location.
6. On the Shortcut Folder page, accept or change the default folder where shortcuts to Cognos Business Viewpoint Server will be installed, and click Next.
7. On the Summary page, click Next.
8. On the Finish page, do one or more of the following:
   • View the transfer log file.
   • View the summary error log file.
   • If you want to see late-breaking information about the product, select to view the Release Notes.
   • Choose to start IBM Cognos Configuration.
   • Click Finish.

Installing Cognos Business Viewpoint Server on Linux and UNIX

Before you install Cognos Business Viewpoint Server, ensure that you have created a server database that will be used by Cognos Business Viewpoint as the data repository.

Procedure
1. On HP-UX, set the `_M_ARENA_OPTS` environment variable as follows:
   
   ```
   _M_ARENA_OPTS 1:4
   ```

   This increases the memory allocation for HP-UX to more closely match that of other UNIX platforms.
2. If installing from a download, go to the location where the installation files were downloaded and extracted.
3. If installing from a disk, mount the disk using Rock Ridge file extensions.
   To mount the disk on HP-UX, do the following:
   • Add the `pfs_mountr` directory in your path.
     For example, use the following commands:
     ```
     PATH=/usr/sbin/:$PATH
     export PATH
     ```
   • To start the required NFS daemons and run the daemons in the background, type the following commands:
     ```
     bg pfs_mountr
     bg pfsd
     ```
   • To mount the drive, type `pfs_mountr -t rr!p <device><mount_dir> -o xlat=unix` For example, `pfs_mountr /dev/c0t2d0 /cdrom -o xlat=unix`.
     You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.
When the installation is complete, type `pfs_umount /cdrom` and kill the pfsd and pfs_mountd daemons to unmount the disk.

4. To start the installation wizard, go to the operating system directory and then type `./issetup`

   **Note:** When you use the issetup command with XWindows, Japanese characters in messages and log files may be corrupted. When installing in Japanese on UNIX or Linux, first set environment variables LANG=C and LC_ALL=C (where C is the language code, for example ja_JP.PCK on Solaris), and then start the installation wizard.

5. Follow the directions in the installation wizard to copy the required files to your computer.

   Install the components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux web servers do not support non-ASCII characters in directory names.

6. On the **Finish** page, do one or more of the following:
   - View the transfer log file.
   - View the summary error log file.
   - If you want to see late-breaking information about the product, select to view the Release Notes.
   - Choose to start IBM Cognos Configuration.
   - Click **Finish**.

7. Append the `install_location/bin` directory to the appropriate library path environment variable.
   - For Solaris and Linux, LD_LIBRARY_PATH
   - For AIX, LIBPATH
   - For HP-UX, SHLIB_PATH

---

**Configuring Cognos Business Viewpoint Server**

Cognos Business Viewpoint Server installs and uses Tomcat as the application server by default.

You can choose to run Cognos Business Viewpoint within IBM WebSphere Application Server instead. For more information, see [Chapter 9, "Configuring IBM Cognos Business Viewpoint Server for IBM WebSphere Application Server," on page 43](#).

**Procedure**

1. Start IBM Cognos Configuration.
   - To start IBM Cognos Configuration on a Windows computer, From the **Start** menu, click **Programs > IBM Cognos Business Viewpoint > IBM Cognos Configuration**.
   - To start IBM Cognos Configuration on a UNIX or Linux computer: Go to the `install_location/bin` directory and then type the following command:

     `./cogconfig.sh`

2. If you want to change the properties for the Tomcat server, expand **Environment**, click **Tomcat Server**, and do one or more of the following:
   - To change the TCP port number on which the Tomcat server listens for client connections, enter a new value in the **HTTP/1.1 port number** box.
The port numbers must not be used by any other application that is running on the same computer.

- To secure the installation, from the **Use SSL port** box, select **True**.
- To change the TCP port number on which the Tomcat server listens for a shutdown request, in the **Shutdown port number** box, enter a new value. The port numbers must not be used by any other application that is running on the same computer.
- To change the amount of time that a session can be idle before timing out, in the **Session timeout** box, specify a new time in minutes.

3. If you want to use Cognos Access Manager (CAM) as the system that users are authenticated against, see Chapter 8, “Configuring IBM Cognos Business Viewpoint Server to use an authentication provider,” on page 33.

4. If your repository is an IBM DB2 database:
   - Expand **Data Access > Business Viewpoint Repository** and click **Database**.
   - In **Database server and port number**, enter the server name and port number, separated by a colon.
     For example, myserver:50000.
   - In **User ID and password**, enter the user ID and password for the user who has unrestricted access to the database.
   - In **Database name**, enter the name of the database.

5. If your repository is an Oracle or Microsoft SQL Server database, do the following:
   - Expand **Data Access** and expand **Business Viewpoint Repository**.
   - Right-click **Database**, and then click **Delete**.
   - Right-click **Business Viewpoint Repository**, click **New Resource > Database**.
   - Enter a name for the resource, select the type of database, and click **OK**.
     The name of the resource appears only in IBM Cognos Configuration.
   - In **Database server and port number**, enter the server name and port number, separated by a colon, of the database computer.
     For example, myserver:1433.
   - In **User ID and password**, enter the user ID and password for the user who has unrestricted access to the database.
   - In **Database name**, enter the name of the Oracle or Microsoft SQL Server database.

6. If you want Cognos Business Viewpoint Studio to be able to send tasks by e-mail, specify a connection to a mail server account.
   For more information, see “Specifying a connection to a mail server account” on page 29.

7. Click **File > Save**.
   If you are prompted with a message stating that IBM Cognos Configuration cannot obtain a CA certificate from Content Manager, click **Yes** to allow you to proceed.

8. Expand **Environment**, right-click **Tomcat Server** and click **Start**.
   The following events occur:
   - IBM Cognos Configuration starts the Cognos Business Viewpoint startup script.
   - The startup script registers the Tomcat server as a Windows service.
   - The script starts the Windows service.
• The Cognos Business Viewpoint server starts.
• The Cognos Business Viewpoint server connects to the database, and creates the Cognos Business Viewpoint tables.

If you make additional changes to the configuration, right-click Tomcat Server, click Stop, and then restart the server. You can also stop and restart the Cognos Business Viewpoint service using the Windows services tool.


Specifying a connection to a mail server account
If you want to send tasks by e-mail using Cognos Business Viewpoint Studio, you must configure a connection to a mail server account.

Procedure
1. Expand Data Access and click Notification.
2. In the SMTP mail server box, type the host name and port of your SMTP (outgoing) mail server, separated by a colon (:).
3. To change the user name and password, do the following:
   • Click the box next to the Account and password box and then click the edit button.
   • Type the user ID and password in the Value - Account and password dialog box and click OK.

If logon credentials are not required for the SMTP server, remove the default information for the Account and password box. When you are prompted for confirmation to leave this box blank, click Yes. Ensure that the default user name has been removed. Otherwise, the default account is used and notifications will not work properly.

4. In the Default sender and Default Reply-To Address boxes, type the appropriate values.

Results
If you do not plan to send tasks by email, or do not want to set up a mail server account immediately, you are not required to. However, when you save the configuration and then you start the services in IBM Cognos Configuration, you will see a warning message when the mail server connection is tested. You can safely ignore the warning.

Testing the Cognos Business Viewpoint Server configuration
After you install Cognos Business Viewpoint Server, you can test the configuration.

Procedure
1. Ensure that the Tomcat service is started.
2. In a browser window, type the URL of Cognos Business Viewpoint Studio:
   http://server_name:9410/bv/main.jsp
3. Login using the user name (admin) and password (admin) for the Cognos Business Viewpoint Administrator account. The user “admin” is the only Business Viewpoint Studio user that does not require an association with an account from an external namespace. After logging in this first time, you can change the credentials for this user. For more information, see the Business Viewpoint Studio User Guide.
Creating a data source in the IBM Cognos Business Intelligence environment

To enable the publishing of data from IBM Cognos Business Viewpoint Studio to IBM Cognos Business Intelligence, you must configure the IBM Cognos BI environment. You do this by using IBM Cognos Administration to create a data source named BusinessViewpoint.

Before you begin

This data source must reference the same repository that you created earlier in "Creating the IBM Cognos Business Viewpoint repository" on page 19.

To use IBM Cognos Administration, you must have administrator privileges in the IBM Cognos BI environment.

For more information about data sources, see the IBM Cognos Administration and Security Guide.

Procedure

1. In IBM Cognos Connection, in the upper-right corner, click Launch > IBM Cognos Administration.
2. On the Configuration tab, click Data Source Connections.
3. Click the new data source button.
4. In the name and description page, type BusinessViewpoint in the name box and, optionally, a description and screen tip, and then click Next.
   **Important:** You must enter the name BusinessViewpoint. Otherwise, attempts to publish from Cognos Business Viewpoint Studio will fail.
5. In the connection page, from the Type box, select the same type of data source for the repository that you created earlier in "Creating the IBM Cognos Business Viewpoint repository" on page 19.
6. Specify the isolation level.
   - If the isolation level is unavailable, click Next.
   - If the isolation level is available, select the default object gateway or specify a value, and then click Next.
   For more information about specifying isolation levels, see the IBM Cognos Administration and Security Guide.
7. Specify the connection parameters for the data source.
   For more information, see the IBM Cognos Administration and Security Guide.
8. Click Test the connection, and then Test to test whether parameters are correct.
   In the Status column, you see if the connection was successful. If it was unsuccessful, click Close, return to the previous steps, and verify your connection parameters. If it was successful, go to the next step.
9. Click Finish.
   The new data source is displayed in Data Source Connections on the Configuration tab.
Configuring IBM Cognos Software Development Kit to run Cognos Business Viewpoint tasks

If you want IBM Cognos Software Development Kit users to be able to automate Cognos Business Viewpoint tasks, you must update the configuration of the Business Intelligence environment.

If you need to automate Cognos Business Viewpoint tasks, use the Cognos Business Viewpoint Software Development Kit instead of the IBM Cognos Software Development Kit.

Procedure
1. Go to the following folder:
   \BI_SDK_installation_location\webapps\p2pd\WEB-INF\classes\
2. Open the file dimensionManagementService.properties in a text editor.
3. Edit the following properties:
   - bv.server.host=Business Viewpoint server name
     The default value is localhost
   - bv.server.port=Business Viewpoint server port
     The default value is 9410
   - c8.system.name=IBM Cognos system name
     where IBM Cognos system name is the name of the Cognos system that was set in IBM Cognos Business Viewpoint Studio. For more information, see the IBM Cognos Business Viewpoint Studio User Guide.

Results

To test the configuration, see the IBM Cognos Software Development Kit Developer Guide.
Chapter 8. Configuring IBM Cognos Business Viewpoint Server to use an authentication provider

This section describes how to configure IBM Cognos Business Viewpoint Server with a namespace for the type of authentication provider in your environment. You can configure multiple namespaces for authentication and then have users choose which namespace they want to use when they log in.

IBM Cognos Business Viewpoint Server supports the following types of servers as authentication providers:
- Active Directory Server
- LDAP
- NTLM namespace

Some authentication providers require libraries external to the IBM Cognos Business Viewpoint Server environment to be available. If these libraries are not available on the Linux operating system, the authentication provider cannot be initialized.

If you want to configure Active Directory Server or NTLM as your authentication source, you must install IBM Cognos Business Viewpoint on a non-Linux computer.

Configuring IBM Cognos Business Viewpoint Server to use Active Directory Server

If you install IBM Cognos Business Viewpoint on a Windows computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

If you install IBM Cognos Business Viewpoint on a UNIX computer, you must instead use an LDAP namespace to configure Active Directory as your authentication source. If you install IBM Cognos Business Viewpoint on Windows and UNIX computers, you must use an LDAP namespace to configure Active Directory on all IBM Cognos Business Viewpoint computers. When you use an LDAP namespace to authenticate against Active Directory Server, you are limited to LDAP features only. You do not have access to Active Directory features such as advanced properties for domains.

If you install IBM Cognos Business Viewpoint on a Linux computer, the same restrictions apply as for UNIX. You must use an LDAP namespace to configure Active Directory as your authentication source.

For more information, see "Configuring an LDAP namespace for Active Directory Server" on page 37.

You cannot connect to the Active Directory Global Catalog, which is a caching server for Active Directory Server. If the connection uses port 3268, you must change it. By default, Active Directory Server uses port 389.
Configuring an Active Directory namespace
You can use Active Directory Server as your authentication provider.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the appropriate namespace and then click OK.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
6. Specify the values for all other required properties to ensure that IBM Cognos Business Viewpoint components can locate and use your existing authentication provider.
7. Specify the values for the Host and port property.
   To support Active Directory Server failover, you can specify the domain name instead of a specific domain controller. For example, use mydomain.com:389 instead of dc1.mydomain.com:389.
8. If you want to be able to search for details when authentication fails, specify the user ID and password for the Binding credentials property.
   Use the credentials of an Active Directory Server user who has search and read privileges for that server.
9. Click File > Save.
10. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource, and click Test.

Including or excluding domains by using advanced properties
When you configure an authentication namespace for IBM Cognos Business Viewpoint, users from only one domain can log in. By using the Advanced properties for Active Directory Server, users from related (parent-child) domains and unrelated domain trees within the same forest can also log in.

If you set a parameter named chaseReferrals to true, users in the original authenticated domain and all child domains of the domain tree can log in to IBM Cognos Business Viewpoint. Users above the original authenticated domain or in a different domain tree cannot log in.

If you set a parameter named MultiDomainTrees to true, users in all domain trees in the forest can log in to IBM Cognos Business Viewpoint.

Procedure
1. On every computer where you installed IBM Cognos Business Viewpoint, open IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the Active Directory namespace.
3. In the Properties window, specify the Host and port property:
   • For users in one domain, specify the host and port of a domain controller for the single domain.
   • For users in one domain tree, specify the host and port of the top-level controller for the domain tree.
For users in all domain trees in the forest, specify the host and port of any domain controller in the forest.

4. Click in the Value column for Advanced properties and click the edit button.
5. In the Value - Advanced properties window, click Add.
6. Specify two new properties, chaseReferrals and MultiDomainTrees, with the following values:

<table>
<thead>
<tr>
<th>Authentication for</th>
<th>chaseReferrals</th>
<th>MultiDomainTrees</th>
</tr>
</thead>
<tbody>
<tr>
<td>One domain</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td>One domain tree</td>
<td>True</td>
<td>False</td>
</tr>
<tr>
<td>All domain trees in the forest</td>
<td>True</td>
<td>True</td>
</tr>
</tbody>
</table>

7. Click OK.
8. Click File > Save.

Configuring IBM Cognos Business Viewpoint Server to use LDAP

You can configure IBM Cognos Business Viewpoint Server to use an LDAP namespace as the authentication provider. You can use an LDAP namespace for users that are stored in an LDAP user directory, Active Directory Server, IBM Directory Server, Novell Directory Server, or Sun Java System Directory Server.

To bind a user to the LDAP server, the LDAP authentication provider must construct the distinguished name (DN). If the Use external identity property is set to True, it uses the External identity mapping property to try to resolve the user’s DN. If it cannot find the environment variable or the DN in the LDAP server, it attempts to use the User lookup property to construct the DN.

If users are stored hierarchically within the directory server, you can configure the User lookup and External identity mapping properties to use search filters. When the LDAP authentication provider performs searches, it uses the filters you specify for the User lookup and External identity mapping properties. It also binds to the directory server using the value you specify for the Bind user DN and password property or using anonymous if no value is specified.

When an LDAP namespace has been configured to use the External identity mapping property for authentication, the LDAP provider binds to the directory server using the Bind user DN and password or using anonymous if no value is specified. All users who log in to IBM Cognos products using external identity mapping see the same users, groups, and folders as the Bind user.

If you do not use external identity mapping, you can specify whether to use bind credentials to search the LDAP directory server by configuring the Use bind credentials for search property. When the property is enabled, searches are performed using the bind user credentials or using anonymous if no value is specified. When the property is disabled, which is the default setting, searches are performed using the credentials of the logged-on user. The benefit of using bind credentials is that instead of changing administrative rights for multiple users, you can change the administrative rights for the bind user only.
Important: If you use a DN syntax, such as uid=${userID}, ou=mycompany.com, for the properties User lookup, External identity mapping, or Bind user DN and password, you must escape all special characters that are used in the DN. If you use a search syntax, such as (uid=${userID}), for the properties User lookup or External identity mapping, you must not escape special characters that are used in the DN.

Configuring an LDAP namespace

You can configure IBM Cognos Business Viewpoint Server to use an LDAP namespace when the users are stored in an LDAP user directory. The LDAP user directory may be accessed from within another server environment, such as Active Directory Server or eTrust SiteMinder.

You can also use LDAP authentication with DB2 data sources by specifying the LDAP namespace when you set up the data source connection.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New Resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type box, click the appropriate namespace, and click OK.
5. In the Properties window, in the Namespace ID box, specify a unique identifier for the namespace.
6. Specify the values for all other required properties to ensure that IBM Cognos Business Viewpoint Server can locate and use your existing authentication provider.
7. If you want the LDAP authentication provider to bind to the directory server using a specific Bind user DN and password when performing searches, then specify these values.
   If no values are specified, the LDAP authentication provider binds as anonymous.
   If external identity mapping is enabled, Bind user DN and password are used for all LDAP access. If external identity mapping is not enabled, Bind user DN and password are used only when a search filter is specified for the User lookup property. In that case, when the user DN is established, subsequent requests to the LDAP server are executed under the authentication context of the end user.
8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that Use external identity is set to False.
   - Set Use bind credentials for search to True.
   - Specify the user ID and password for Bind user DN and password.
   If you do not specify a user ID and password, and anonymous access is enabled, the search is done using anonymous.
9. Check the mapping settings for required objects and attributes.
   Depending on the LDAP configuration, you may have to change some default values to ensure successful communication between IBM Cognos Business Viewpoint Server and the LDAP server.
LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

10. Click File > Save.

11. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource, and click Test.

**Configuring an LDAP namespace for Active Directory Server**

If you configure a new LDAP namespace for use with an Active Directory Server, you must modify the necessary settings and change the values for all properties of the Active Directory objects.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the appropriate namespace and then click OK.
5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.

   **Note:** Do not use colons (:) in the Namespace ID property.

6. Specify the values for all other required properties to ensure that IBM Cognos Business Viewpoint Server can locate and use your existing authentication provider.

   The following settings are examples:
   - For **User lookup**, specify (sAMAccountName=${userID})
   - For **Bind user DN and password**, specify user@domain
   - For **Unique identifier**, specify objectGUID

7. If you want the LDAP authentication provider to bind to the directory server using a specific user ID and password when performing searches, then specify these in the **Bind user DN and password** box.
   If no values are specified, the LDAP authentication provider binds anonymously.

8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that **Use external identity** is set to **False**.
   - Set **Use bind credentials for search** to **True**.
   - Specify the user ID and password for **Bind user DN and password**.

9. To configure the LDAP advanced mapping properties for use with the Active Directory Server objects, use the values specified in the following table.

   LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalUnit,organization,container</td>
</tr>
<tr>
<td>Mappings</td>
<td>LDAP property</td>
<td>LDAP value</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
<td>------------</td>
</tr>
<tr>
<td>Description</td>
<td>description</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>ou,o,cn</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>group</td>
</tr>
<tr>
<td>Description</td>
<td>description</td>
<td></td>
</tr>
<tr>
<td>Member</td>
<td>member</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>cn</td>
<td></td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>user</td>
</tr>
<tr>
<td>Business phone</td>
<td>telephonenumber</td>
<td></td>
</tr>
<tr>
<td>Content locale</td>
<td>(leave blank)</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>description</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>mail</td>
<td></td>
</tr>
<tr>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
<td></td>
</tr>
<tr>
<td>Given name</td>
<td>givenname</td>
<td></td>
</tr>
<tr>
<td>Home phone</td>
<td>homephone</td>
<td></td>
</tr>
<tr>
<td>Mobile phone</td>
<td>mobile</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>displayName</td>
<td></td>
</tr>
<tr>
<td>Pager phone</td>
<td>pager</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>unicodePwd</td>
<td></td>
</tr>
<tr>
<td>Postal address</td>
<td>postaladdress</td>
<td></td>
</tr>
<tr>
<td>Product locale</td>
<td>(leave blank)</td>
<td></td>
</tr>
<tr>
<td>Surname</td>
<td>sn</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>sAMAccountName</td>
<td></td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default Active Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

10. Click **File > Save**.
11. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource, and click **Test**.
Replace Operation

The replace operation returns a copy of the string with all occurrences of the old substring replaced by the new substring.

Notes:
- The backslash character (\) is used to escape the characters in the function parameters. Characters such as a backslash (\) and a double quotation mark (") need escaping.
- Nested function calls are not supported.
- Special characters are not supported.

Syntax

${replace(str, old, new)}

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>str</td>
<td>The string to search.</td>
</tr>
<tr>
<td>old</td>
<td>The substring to be replaced by the new substring.</td>
</tr>
<tr>
<td>new</td>
<td>The substring that replaces the old substring.</td>
</tr>
</tbody>
</table>

Examples

${replace(${environment("REMOTE_USER")},"NAMERICA\","")}

${replace(${environment("REMOTE_USER")},"NAMERICA\",")"}
3. In the Name box, type a name for your authentication namespace.

4. In the Type list, click NTLM and click OK.

5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.

   **Note:** Do not use colons (:) in the NamespaceID property.

6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.

7. Click File > Save.

8. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource, and click Test.

---

**Testing the namespaces**

After you configure one or more new namespaces for IBM Cognos Business Viewpoint Server, you can test the namespaces. The test can occur before or after you start the IBM Cognos Business Viewpoint Server service. You can test all namespaces at the same time or test them individually.

**Procedure**

- To test all namespaces:
  - In the Explorer window, right-click Authentication and click Test.
  - IBM Cognos Business Viewpoint Server loads, initializes, and configures the provider libraries for one namespace before testing the next namespace.

  **Tip:** To cancel a namespace test, click Cancel. The test stops when the current namespace test is complete.

- To test a single namespace:
  - In the Explorer window, under Authentication, right-click the new authentication resource, and click Test.
  - IBM Cognos Business Viewpoint Server loads, initializes, and configures the provider libraries for the namespace.

---

**Delete an Authentication Provider**

If they are no longer required, you can delete namespaces that you added or unconfigured namespaces that IBM Cognos Business Viewpoint Server detected.

**Important:** You must not delete the IBM Cognos Business Viewpoint namespace. It contains authentication data that pertains to all users and is required to save the configuration.

When you delete a namespace, you can no longer log on to the namespace. Security data for the namespace remains in IBM Cognos Business Viewpoint.

**Procedure**

1. Start IBM Cognos Configuration.

2. In the Explorer window, under Security > Authentication, right-click the namespace and click Delete.

3. Click Yes to confirm.

   The namespace disappears from the Explorer window and you can no longer log on to the namespace on that computer.
4. Click **File > Save**.
5. Repeat steps 2 to 4 for each computer where you installed IBM Cognos Business Viewpoint.
Chapter 9. Configuring IBM Cognos Business Viewpoint
Server for IBM WebSphere Application Server

IBM Cognos Business Viewpoint Server installs and uses Tomcat as the application
server by default. You can choose to run IBM Cognos Business Viewpoint within
IBM WebSphere Application Server instead.

Procedure

1. Create a separate JVM instance, if necessary. For more information, see
   “Creating a separate JVM instance.”

2. Check that IBM Cognos Business Viewpoint components are properly set up.
   For more information, see “Checking the setup of IBM Cognos Business
   Viewpoint.”

3. Back up the existing IBM Cognos Business Viewpoint configuration. For more
   information, see “Backing up the existing IBM Cognos Business Viewpoint
   configuration” on page 44.

4. Set environment variables. For more information, see “Setting environment
   variables” on page 45.

5. Configure IBM Cognos Business Viewpoint to run within WebSphere
   Application Server. For more information, see “Configuring IBM Cognos
   Business Viewpoint to run within WebSphere Application Server” on page 46.

6. Build the IBM Cognos Business Viewpoint application file. For more
   information, see “Building the IBM Cognos Business Viewpoint application file”
   on page 46.

7. Configure the application server properties and deploy IBM Cognos Business
   Viewpoint. For more information, see “Deploy the IBM Cognos Business
   Viewpoint application” on page 47.

Creating a separate JVM instance

To eliminate potential java class or system resource conflicts, IBM Cognos Business
Viewpoint must be run in a Java Virtual Machine (JVM) instance isolated from
other existing applications. This ensures that IBM Cognos Business Viewpoint does
not affect any existing customer applications. When possible, IBM Cognos Business
Viewpoint must be installed in a JVM instance that is separate from the application
server admin processes to isolate both IBM Cognos Business Viewpoint and the
administrative functions of the application server.

An isolated JVM instance can be established by creating a separate server instance
in IBM WebSphere.

Checking the setup of IBM Cognos Business Viewpoint

Ensure that the following is done before you set up IBM Cognos Business
Viewpoint to run on the application server:

• Cognos Business Viewpoint components are installed.
• The application server is installed and operational on each computer where IBM
  Cognos Business Viewpoint components are installed.

For more information about installation, see your application server
documentation.

© Copyright IBM Corp. 2008, 2011
The application server user account has full access permissions for the IBM Cognos Business Viewpoint installation.

**Tip:** Create a new UNIX or Linux group named cognos. This group must contain the user that starts the application server and the user that owns the IBM Cognos files. Change the group ownership of the IBM Cognos files to the cognos group and change the file permissions for all IBM Cognos files to GROUP READABLE/WRITABLE/EXECUTABLE. For simplicity, you can also use the application server user account to install and run IBM Cognos Business Viewpoint components.

---

**Backing up the existing IBM Cognos Business Viewpoint configuration**

You must back up the existing IBM Cognos Business Viewpoint configuration if IBM Cognos Business Viewpoint components are running on an application server (including Tomcat) and you are changing to an application server that ships with its own JVM. You must also back up existing IBM Cognos Business Viewpoint configuration if you must change the JVM you are using.

Before configuring IBM Cognos Business Viewpoint components to run on the new application server or JVM, you must do the following:

- Back up the configuration information by exporting it. Any encrypted data is decrypted during the export.
- Back up the cryptographic keys by saving them to an alternate location. New cryptographic keys must be created using the same JVM that the application server uses. Because these keys can be created only if the previous keys are deleted, it is important to back up the previous keys.

To ensure the security and integrity of your IBM Cognos Business Viewpoint configuration, back up the configuration information and cryptographic keys to a directory that is protected from unauthorized or inappropriate access.

**Tip:** To check if any cryptographic keys exist, look in the `BusinessViewpoint_location/configuration` directory. Cryptographic keys exist if this directory includes the following subdirectories: csk, encryptkeypair or signkeypair.

**Procedure**

1. In IBM Cognos Configuration, click **File > Export As** and save the configuration information in a decrypted format. When naming the file, use a name such as "decrypted.xml".

   Because passwords are stored in plain text, export the data to a directory that is protected from unauthorized or inappropriate access. You are prompted to acknowledge that the export is an unsecure operation.

2. Stop the IBM Cognos Business Viewpoint service:
   - If you use Tomcat, stop the IBM Cognos Business Viewpoint service and close IBM Cognos Configuration.
   - If you use an application server other than Tomcat, shut down IBM Cognos Business Viewpoint in your environment.

3. Back up any existing cryptographic keys by saving the appropriate files and directories to an alternate location that is secure.

   The files are:
   - `BusinessViewpoint_location/configuration/cogstartup.xml`
   - `BusinessViewpoint_location/configuration/caSerial`
4. Delete the caSerial and cogconfig.prefs files and the three directories: csk, encryptkeypair, and signkeypair.

5. Replace the BusinessViewpoint_location/configuration/cogstartup.xml file with the file that contains the data exported from IBM Cognos Configuration (for example, "decrypted.xml").

**Important:** In the BusinessViewpoint_location/configuration directory, the file must use the name "cogstartup.xml".

The information in this file will be automatically re-encrypted using new cryptographic keys when you save the configuration in IBM Cognos Configuration.

---

### Setting environment variables

You must set environment variables to identify the location of the JVM environment and the library path. You can set environment variables using any of the following methods:

- On the Microsoft Windows operating system, set a system or user variable, or edit the application server's startup environment script.

  If you set a user variable, ensure that you set it for the user account that will run the application server.

  By default, IBM WebSphere Windows service is installed to run under the Local System account. If you update the environment variables or add new environment variables, you must restart the computer before these changes affect the WebSphere service that runs under the Local System account.

- On either the UNIX and Linux operating system, set an environment variable in the user profile, or edit the application server's startup or environment script.

**Tip:** Most WebSphere versions ship with a script specifically intended for setting environment variables. For example, some WebSphere versions ship with setupCmdLine.bat. You can modify this script to set appropriate values for use with IBM Cognos Business Viewpoint components. Most of these scripts set the JAVA_HOME environment variable by default.

### Procedure

1. Set the JAVA_HOME environment variable to point to the JVM used by the application server.

   **Note:** If the application server ships with a JVM, then you must set the JAVA_HOME environment variable to reference it.

   IBM Cognos Configuration uses this variable to create encryption keys, for IBM Cognos Business Viewpoint components, that are compatible with the JVM used by the application server.

2. Append BusinessViewpoint_location/bin to the appropriate environment variable. This variable is used to locate the IBM Cognos library files.
### Operating system Environment variable

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>PATH</td>
</tr>
<tr>
<td>AIX</td>
<td>LIBPATH</td>
</tr>
<tr>
<td>Solaris and Linux</td>
<td>LD_LIBRARY_PATH</td>
</tr>
<tr>
<td>HP-UX</td>
<td>SHLIB_PATH</td>
</tr>
</tbody>
</table>

### Configuring IBM Cognos Business Viewpoint to run within WebSphere Application Server

IBM Cognos Business Viewpoint must be configured with IBM WebSphere application server JVM, and the configuration must be saved to create new cryptographic keys. IBM Cognos Configuration uses the JVM that is defined by the JAVA_HOME environment variable.

**Important:** To ensure valid encryption keys are generated you must set the JAVA_HOME environment variable to the JVM supplied or used by WebSphere and then copy the security provider files before you run IBM Cognos Configuration.

**Procedure**

1. Start IBM Cognos Configuration:
   - On the Microsoft Windows operating system, type `cogconfig.bat` in a command window or select **IBM Cognos Configuration** from the **Start** menu.
   - On the UNIX or Linux operating system, type `cogconfig.sh` (if you have existing incompatible encryption keys, you are prompted to automatically generate new ones at this time).

   **Tip:** Ensure that the existing keys are backed up to a secure location before proceeding. There is no undo action available after you generate new keys.

2. Complete the required configuration changes, such as specifying properties for the IBM Cognos Business Viewpoint repository and entering user IDs and passwords.
3. Save the configuration.

   New cryptographic keys are created using the JVM that is defined by the JAVA_HOME variable.


### Building the IBM Cognos Business Viewpoint application file

Use the build application script to create the application file that will be deployed to the IBM WebSphere application server.

**Procedure**

1. Change the current directory to `BusinessViewpoint_location\war\bv`.
2. Run the build application script.
On the Microsoft Windows operating system:
- Run build.bat.

On the UNIX operating system:
- Edit build.sh to set the JAVA_HOME variable.
- Run build.sh.

3. Verify that BusinessViewpoint_location/bv.ear file was build successfully.
   
   Tip: It is not necessary to rebuild or redeploy the application file when you make configuration changes because configuration information is stored externally to the application.

---

**Deploy the IBM Cognos Business Viewpoint application**

You must deploy the IBM Cognos Business Viewpoint application file to the IBM WebSphere application server.

**Procedure**

1. Start the WebSphere Application Server, and then access the WebSphere Administrative Console.

2. Use the IBM Cognos Business Viewpoint application file (bv.ear) to install a new Enterprise Application.
   
   You must deploy the application file on the same computer on which you installed IBM Cognos Business Viewpoint.
   
   For more information on how to deploy an .ear file, see the WebSphere documentation.

   **Important:** You must update the class loader order for the bv.war module.

   IBM Cognos Business Viewpoint enterprise application includes two web modules: 'bv' (bv.war) and 'shared' (shared.war). You must update the class loader order in the 'bv' web module. It is not necessary to update the 'shared' web module.

   By default, WebSphere application server sets the class loader order to parent class loader first and application class loader last. You must change the class loader order to application class loader first and parent class loader last.

   For more information on how to change the class loader order in the web modules of an enterprise application, see the WebSphere documentation.

3. Set the memory used by the JVM.
   
   Usually, the memory is set by adding or changing the initial and maximum Java heap size. For information about these parameters, see the JVM or application server documentation.

   **Tip:** A minimum of 256 MB and a maximum of 768 MB are suggested starting values. You can change these values to suit your environment.

4. Stop the WebSphere server.

5. Go to the following location:
   
   `<WebSphere Install Root>/AppServer/profiles/AppSrv01/installedApps/<serverNodeCell>/IBM Cognos Business Viewpoint.ear/bv.war/WEB-INF/`

   6. Create a file named cogroot.link

   7. In the file, add the <bv install root> directory path.

   8. Save the file.

   9. Restart the WebSphere server.
10. Verify that IBM Cognos Business Viewpoint is running by doing the following:
   • In a browser window, type the URL of IBM Cognos Business Viewpoint Studio: http://server_name:9080/bv/main.jsp
     Use a different port number if you changed the default WebSphere application port.
   • Enter the user name and password for the IBM Cognos Business Viewpoint Administrator account.
Chapter 10. Maintaining IBM Cognos Business Viewpoint

To ensure maximum performance and availability for Cognos Business Viewpoint, you should perform some administration tasks on a regular basis.

Optimizing IBM Cognos Business Viewpoint

Over time, the environment for your IBM Cognos Business Viewpoint system will change as user populations grow, processing requests increase in number and complexity, and other aspects of infrastructure change. These changes can affect performance. Therefore, it is important to monitor and tune performance regularly.

Here are some things you can discuss with your database administrator:

- Estimating the number of users you expect to have and when you expect them to use Business Viewpoint Studio.

  Named users is your total user population. Active users is a subset of those who are logged on and can demand system resources. Concurrent users are the ones simultaneously demanding system resources.

  As a general rule, the ratio of named to active to concurrent users for business intelligence applications is about 100:10:1. In other words, for every 1000 named users there are 100 active users and 10 concurrent users.

- Keeping the database tuned and optimized.

  It is important to maintain the performance of your database. If Business Viewpoint Studio demands more of a database than it can provide, you may experience increased response times and degradation in performance and scalability. For information about turning your database, see the documentation for your database.

- Changing memory settings of your application server.

  The memory allocation strategy for your application server depends on the available capacity of your resources, and on the resource needs of other applications running on the server. In general, configure your application server with a minimum of 768 Megabytes of memory for multi-user applications.

  To configure Apache Tomcat or IBM WebSphere, use IBM Cognos Configuration or alternative methods.

Backing up and restoring data

To minimize down time, you should back up your Business Viewpoint data and repository regularly.

In addition, you should back up and restore data when you want to perform the following tasks:

- Moving Business Viewpoint to a new server.

- Moving from a test environment to a production environment.

- Migrating data from one database platform to a database platform of a different type.

  For example, if you want to move an Oracle repository to an IBM DB2 repository, you back up the Oracle database and restore it using a DB2 database.

- Upgrading from an earlier version of Business Viewpoint.
Backing up and restoring the Cognos Business Viewpoint repository using database tools

A database administrator (DBA) should perform regular backups of the database that contains the Business Viewpoint repository.

Before you begin

You must have database administrator authority to backup or restore databases.

Backing up the database

Procedure

1. Review the backup documentation that is specific to the type of database that you have.
2. Back up the Business Viewpoint schema and tables at regular intervals and store them according to your IT department’s backup and recovery plan.

What to do next

You can implement a database backup script that backs up the database once a day. The backup files should then be backed up to a secure remote server using your preferred remote file storage methods. The backup method needs to be determined by a specific capacity plan analysis based on database size, usage, and interval.

Restoring the database

Procedure

1. Review the restore documentation that is specific to the type of database that you have.
2. Acquire the database backup file and restore it according to the type of database that you want to use.
3. Start Business Viewpoint Configuration and modify the existing Content Store configuration so that the Business Viewpoint server points to the restored database instance.

Backing up the Business Viewpoint data using Business Viewpoint Studio

You can use Business Viewpoint Studio to perform regular Business Viewpoint backups.

Before you begin

To ensure that no one uses Business Viewpoint during the backup operation:

1. Stop the Business Viewpoint service.
2. Change the application server port number for Business Viewpoint to a value that users will not access during the backup process. Use this port number when using Business Viewpoint Studio to create the Business Viewpoint backup.
3. Restart the Business Viewpoint service.

About this task

You must be a Business Viewpoint Administrator to perform the backup operation.
Procedure

1. In Business Viewpoint Studio, click **Tools > Administration**.
2. Click the **Backup and Restore** tab.
   
   This creates an encrypted backup file of all the Business Viewpoint tables and records. The encrypted backup file has a version number associated with it and can subsequently be migrated into existing or future versions of Business Viewpoint. The backup files are saved on the server where Business Viewpoint Server is installed in the `install_location/migration` directory, where `install_location` represents the Business Viewpoint Server installation path.
3. Click **New Backup** and type a name for the backup file and create a password so that the file is encrypted.

   **Important:** Keep track of the password associated with this backup file, as well as the administrator user login information associated with it. This information will be required when you restore the data. The following table shows the values that you need to record.

<table>
<thead>
<tr>
<th>Backup file information</th>
<th>Sample value</th>
<th>Your Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password used to encrypt the backup file</td>
<td><em>Backup2011</em></td>
<td></td>
</tr>
<tr>
<td>User name (optionally, record the password if using the “admin” user name and the password was changed)</td>
<td><em>admin</em></td>
<td></td>
</tr>
</tbody>
</table>

   The backup files are saved on the server where Business Viewpoint Server is installed in the `install_location/migration` directory, where `install_location` represents the Business Viewpoint Server installation path.
4. Click **OK**.
5. Click **Close**.

What to do next

1. Store the backup files to a secure remote server using your preferred remote file storage methods.
2. Stop the Business Viewpoint service and change the port number back to the value that was used previously.
3. Restart the Business Viewpoint service.

Restoring the Business Viewpoint data using Business Viewpoint Studio

Business Viewpoint administrators can use Business Viewpoint Studio to restore the data that they backed up.

Before you begin

1. Acquire the Business Viewpoint backup .zip file and copy it into the `install_location/migration` directory, where `install_location` represents the Business Viewpoint Server installation path.

   **Note:** You need the password associated with the backup file.
2. Stop the Business Viewpoint service.
3. Change the application server port number for Business Viewpoint to a value that users will not access during the restore process. Use this port number when using Business Viewpoint Studio to restore the Business Viewpoint backup.

4. Restart the Business Viewpoint service.

**About this task**

When you restore data, the contents of the backup file replace all objects in the current Business Viewpoint repository. For example, if you created a Customer dimension in the repository that is not part of the backup file, when you restore the backup file, the Customer dimension is removed along with all other contents.

**Procedure**

1. Start the Business Viewpoint service and log in to Business Viewpoint as the admin user or as a user with administrator privileges.
2. Click **Tools > Administration**.
3. Click the **Backup and Restore** tab.
4. Select the backup file and click **Restore Backup**.
5. Enter the password that was associated with it during the backup creation process.
6. After the data is restored, log in again.

   **Important:** The user name must exist in the backup file.

**Results**

If you set up a Cognos System in Business Viewpoint and it visible from the new server, you can authenticate through it, otherwise, you need to point the system to the appropriate Cognos system in the environment of the new server.

**What to do next**

1. Verify that your data was restored as expected.
2. Stop the Business Viewpoint service and change the port number back to the value that was used previously.
3. Restart the Business Viewpoint service.

---

**Uninstalling IBM Cognos Business Viewpoint Server**

If you no longer require Cognos Business Viewpoint Server or have upgraded to a newer version, uninstall the version of Cognos Business Viewpoint Server that you do not need.

**Before you begin**

Before you uninstall, log out and close Cognos Business Viewpoint Server before you uninstall it. Otherwise, some files might not be removed.

Uninstalling does not remove any files that changed since the installation, such as configuration and user data files. Your installation location remains on your computer, and you retain these files until you delete them.
Uninstall Cognos Business Viewpoint Server on Windows operating systems

Procedure

1. From the Start menu, find the program representing the Cognos Business Viewpoint Server version that you want to remove. For example, click All Programs, IBM Cognos Business Viewpoint Server 8.4.1, Uninstall IBM Cognos Business Viewpoint, Uninstall IBM Cognos Business Viewpoint. The Uninstall wizard appears.

   **Tip:** IBM Cognos Business Viewpoint is the default name of the Program Folder that is created during the installation. If you chose another name, go to that folder to find the program.

2. Follow the instructions to uninstall the components. The cognos_uninst_log.htm file records the activities that the Uninstall wizard performs while uninstalling files.

   **Tip:** To find the log file, look in the Temp directory.

3. Delete all temporary Internet files from the web browser computers. For more information, see your web browser documentation.

Uninstall Cognos Business Viewpoint Server on UNIX or Linux

Procedure

1. Stop Cognos Business Viewpoint Server:
   - If you use XWindows, start IBM Cognos Configuration, and from the Actions menu, click Stop.
   - If you do not use XWindows, run the shutdown.sh command.

2. To uninstall Cognos Business Viewpoint Server, go to the install_location/uninstall directory and type the appropriate command:
   - If you use XWindows, type ./uninst -u v.
   - If you do not use XWindows, do an unattended uninstallation. For more information, see "Setting up an unattended uninstallation" on page 74.

3. Follow the instructions to uninstall the components.

4. Delete all temporary Internet files from the web browser computers. For more information, see your web browser documentation.
Appendix A. Install the IBM Cognos Business Intelligence Samples

Use the IBM Cognos Business Intelligence samples to experiment with Cognos Business Viewpoint features and for troubleshooting.

To use the samples, install them from the IBM Cognos Business Intelligence Samples disk or from the location where you downloaded and extracted the files.

Install in a directory that contains only ASCII characters in the path name. Some servers do not support non-ASCII characters in directory names.

The packages in the samples were created using compatible query mode. If you activated dynamic query mode in IBM Cognos Administration, you must switch back to compatible query mode to use the samples. For more information, see the Administration and Security Guide.

Procedure
1. Insert or mount the IBM Cognos product disk or go to the location where the installation files were downloaded and extracted.
   On UNIX or Linux operating systems, mount the disk using Rock Ridge file extensions.
   On Microsoft Windows operating systems, the installation wizard starts automatically from the product disk.
2. To manually start the installation wizard, go to the operating system directory and do the following:
   • On Windows, double-click the isetup.exe file.
   • On UNIX, type ./issetup
   • On Linux, type ./issetup
   The Welcome page of the installation wizard should appear.
3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language of the user interface to any of the installed languages after installation.
4. Follow the directions in the installation wizard.
   Install the samples in the same location as the server components.
5. In the Finish page of the installation wizard, click Finish.

Setting Up the Samples

To set up the samples, you must restore the samples databases. After setting up the samples, you can use them to learn how to use IBM Cognos Business Viewpoint.

You can manually restore the backup files for the sample databases. For instructions, see “Restore Backup Files for the Samples Databases” on page 57. Starting in Cognos Business Viewpoint version 10.1.1, you can also restore the backup files using scripts. For DB2 databases, see “Restore Backup Files for Sample”.
After you complete these tasks, use the Cognos Business Viewpoint Client relational adapter to access the data in the samples databases.

**Restoring Backup Files for the Samples Databases**

To use the samples, you must restore backup files for the samples databases. This action re-creates multilingual versions of the Great Outdoors databases.

The following sample databases and associated files are provided with IBM Cognos Business Intelligence. For Microsoft SQL Server, each database is delivered as a Microsoft SQL Server backup file. For Oracle, you will need to unzip the file GS_DB_ORA.tar.gz. For DB2, you will need to unzip the file GS_DB.tar.gz. The location for the databases are as follows.

<table>
<thead>
<tr>
<th>Databases</th>
<th>File Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>GS_DB_ORA\data</td>
</tr>
<tr>
<td>DB2</td>
<td>GS_DB\data</td>
</tr>
</tbody>
</table>

**Table 11. Microsoft SQL Server Databases and Files**

<table>
<thead>
<tr>
<th>Database or schema description</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors sales</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors retailers</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors sales data warehouse</td>
<td>GOSALESDW.zip</td>
</tr>
<tr>
<td>Great Outdoors market research</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors human resources</td>
<td>GOSALES.zip</td>
</tr>
</tbody>
</table>

**Table 12. Oracle Databases and Files**

<table>
<thead>
<tr>
<th>Database or schema description</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors sales</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors retailers</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors sales data warehouse</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors market research</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors human resources</td>
<td>GS_DB_ORA.tar.gz</td>
</tr>
</tbody>
</table>

**Table 13. DB2 Databases and Files**

<table>
<thead>
<tr>
<th>Database or schema description</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors sales</td>
<td>GS_DB.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors retailers</td>
<td>GS_DB.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors sales data warehouse</td>
<td>GS_DB.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors market research</td>
<td>GS_DB.tar.gz</td>
</tr>
<tr>
<td>Great Outdoors human resources</td>
<td>GS_DB.tar.gz</td>
</tr>
</tbody>
</table>

When restoring the samples databases, ensure that you do the following:
- Give the restored databases the same names as the backup or export file names.
The names are case-sensitive.
You use the correct username and password.

- Create users with select privileges for tables in multiple schemas.
  Setup for the GO Data Warehouse packages specifies a single connection object
  and user signon. This requires a single user named GOSALESDW with the select
  privilege to tables in a single schema named GOSALESDW.
  Setup for the GO Sales packages specifies a single connection object and user
  signon. This requires a single user named GOSALES with the select privilege to
  tables in four schemas: GOSALES, GOSALESHR, GOSALESMR, and
  GOSALESRT.
- Use the UTF-8 character set on the Microsoft Windows operating system
  computer that is the Oracle or DB2 client to see reports in multiple languages.
  For DB2, you must set the DB2CODEPAGE environment variable to a value of
  1208. For Oracle, you must set the NLS_LANG environment variable to a value
  that is specific to a region. For example, set NLS_LANG for Americas to
  American_America.UTF8.
- Have sufficient disk space available in the target location. Reserve 150MB for the
  GO Sales data (four schemas) and 200MB for the GO Data Warehouse data (one
  schema).

**Oracle Considerations**

To create foreign key constraints in tables that reference different schemas, you
must run gs_or_modify.sql, found in the same folder as the .dmp files.

**Microsoft SQL Server Considerations**

If you restore the Microsoft SQL Server backup files, you must use Microsoft SQL
Server 2000 or Microsoft SQL Server 2005. Ensure that TCP/IP connectivity is used
for the Microsoft SQL Server.

**DB2 Considerations**

The data files for db2move and the scripts, to add constraints, are located in the
data directory. The data directory is created when you unzip the GS_DB.tar.gz file.

If you use WinZip to extract the DB2 move file on Windows, ensure that the TAR
file smart CR/LF conversion option is not selected.

After extracting the DB2 move file, restore the schemas to a database named
GS_DB.

To add views, constraints, user privileges, and stored procedures to GS_DB,
prepare and run the gs_db_modify files included with the samples in the following
order:

- Update the user name and password at the top of the gs_db_modify.sql and
  save it.
- Execute gs_db_modify.bat

**Note:** If the script file attempts to create a stored procedure where the procedure
does not exist an error is generated. This error does not affect the samples.

**Restore Backup Files for the Samples Databases**

Use this procedure to restore backup files.
Procedure

1. On the computer where IBM Cognos Business Viewpoint Server is installed, go to the sql server, oracle, or db2 directory located in $c10_location/webcontent/samples/datasources.

2. If required, copy the backup files for the samples databases to your database backup directory.
   To ensure the security and integrity of Cognos Business Viewpoint Server, copy the files to a directory that is protected from unauthorized or inappropriate access.

3. Restore the samples databases using your database management tool.

   Tip:
   - For SQL backup files, restore the database from a device, and ensure that the restore locations are correct for the .ldf and .mdf database files. For more information, see the Microsoft SQL Server documentation or the IBM Cognos Knowledge Base on the IBM Cognos Customer Center (http://www.ibm.com/software/data/cognos/customercenter/).
   - For DB2, when you create the GS_DB database, create a buffer pool with a page size of 16 KB and an associated tablespace.

4. For each database, create at least one user who has select permissions for all the tables in the restored databases.

Results

You can now use the Cognos Business Viewpoint Client relational adapter to connect to the samples databases.

Restore Backup Files for Sample Databases for DB2 Using Scripts

You can use scripts to restore backup files for sample databases for DB2.

To set up the sample database, you must extract the GS_DB.tar.gz file, customize a configuration file, and run the setup script.

There are prerequisites for installing the Great Outdoors sample database for DB2 on Linux, UNIX and Windows. Before you can install the sample databases, you must verify or configure privileges.

1. Extract the GS_DB.tar.gz file and retain the original directory structure. If you use WinZip to extract the DB2 move file on Microsoft Windows operating system, ensure that the TAR file smart CR/LF conversion option is not selected.

2. On Linux and UNIX operating systems, modify the file permissions on the setupGSDB.sh file so that it is executable: chmod u+x setupGSDB.sh.

3. Ensure that the user ID used to set up the database has DBADM authority or the following authorities in DB2:
   - CREATETAB
   - CREATE_NOT_FENCED_ROUTINE
   - LOAD

Optional: Editing the configuration file

The configuration file contains the default configuration options that are used when creating the GOSALES data. The default configuration settings are.
<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_INST</td>
<td>GS_DB</td>
<td>Used to set the name or alias of the database.</td>
</tr>
<tr>
<td>GOSALES_CREATEDB</td>
<td></td>
<td>Optional: Causes an existing database with the same name to be dropped.</td>
</tr>
<tr>
<td>GOSALES_DB_TERRITORY</td>
<td>US</td>
<td>When creating a database this is the territory of the UTF-8 database that is created.</td>
</tr>
<tr>
<td>GOSALES_BP</td>
<td>GOSALES_BP</td>
<td>Optional: Enter the buffer pool and tablespace name, if these are to be created by the script.</td>
</tr>
<tr>
<td>GOSALES_TS</td>
<td>GOSALES_TS</td>
<td></td>
</tr>
<tr>
<td>GOSALES_GRANTEES</td>
<td>GOSALES, DB2ADMIN</td>
<td>Enter the list of users, groups or PUBLIC that will have CONTROL permissions for the GOSALES, GOSALESHR, GOSALESMR and GOSALESRT schemas. This string needs to follow the syntax of the GRANT command.</td>
</tr>
<tr>
<td>GOSALESDW_GRANTEES</td>
<td>GOSALESDW</td>
<td>Enter the list of users, groups or PUBLIC that will have CONTROL permissions for the GOSALESDW schema.</td>
</tr>
<tr>
<td></td>
<td>DB2ADMIN</td>
<td></td>
</tr>
<tr>
<td>GOSALES_DPF</td>
<td>N</td>
<td>Change to 'Y' if installing a database partitioned environment (DPF)</td>
</tr>
<tr>
<td>GOSALES_SCHEMA</td>
<td>GOSALES</td>
<td>Enter the names to be used for each schema.</td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA</td>
<td>GOSALESHR</td>
<td></td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA</td>
<td>GOSALESMR</td>
<td></td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA</td>
<td>GOSALESRT</td>
<td></td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA</td>
<td>GOSALESDW</td>
<td></td>
</tr>
</tbody>
</table>

You can customize the sample configuration file to use settings other than the default values.

The setup script creates the GS_DB database, table spaces, tables, views, grants privileges, and modifies the schema names for the sample database. In most situations, you can accept the default options. If you want to change the database name or modify the users or groups that have permissions on the data, you must update the GOSalesConfig configuration file.

Edit the configuration file by using a text editor.

Note: If you edit UNIX shell scripts in a Windows environment, ensure that you preserve the UNIX line endings.
The configuration file on Windows is GOSalesConfig.bat. The configuration file on UNIX is GOSalesConfig.sh.

By default, the GS_DB database name is used and permissions are granted to the DB2ADMIN (Linux, UNIX, Windows) and GOSALES users.

Running the setup script in interactive mode

In interactive mode, the setupGSDB script prompts you to confirm or provide configuration information for the GS_DB database installation. You can accept the default settings or provide different settings to replace the defaults.

- Run the setup script for your operating system.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>In a DB2 command window, change to the GS_DB/win directory and run the setupGSDB.bat script.</td>
</tr>
<tr>
<td>UNIX</td>
<td>From a shell prompt, source the db2profile change to the GS_DB/unix directory, and run the setupGSDB.sh script.</td>
</tr>
</tbody>
</table>

- Press Enter to proceed. The script displays a summary of your choices before you commit to changes to your environment. If you approve the choices, press Enter and the script makes the changes. For example:

Please confirm the following settings:
Database Name: GS_DB
Drop and Recreate Database: Y
DPF environment: N
Create a 16k Bufferpool named: GOSALES_BP
Create a 16k Tablespace named: GOSALES_TS
GOSALES Grant users/groups: GOSALES, DB2ADMIN
GOSALESDW Grant users/groups: GOSALESDW, DB2ADMIN
Administration User Name: db2admin
Import the sample data to the following schemas:
GOSALES
GOSALESHR
GOSALESMR
GOSALESRRT
GOSALESDW
WARNING: If the database GS_DB already exists it will be dropped
Continue creating the sample data with these settings? (Y/N) Default=Y:

The GS_DB database is set up.

Running the setup script with command line options

The setupGSDB script lets you provide information on the command line to reduce the number of prompts from the script.

From a command line, run the script for your operating system.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>setupGSDB.bat</td>
</tr>
<tr>
<td>UNIX</td>
<td>setupGSDB.sh</td>
</tr>
</tbody>
</table>

You can run the setupGSDB script with the following options:
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-createdb</td>
<td>Creates the database. This option drops any existing database with the same name. It creates the required buffer pool and table space.</td>
</tr>
<tr>
<td>-database database name</td>
<td>Specifies the name of the database. This value overrides the default value of GS_DB.</td>
</tr>
<tr>
<td>-userid administration_user_ID</td>
<td>Specifies the name of the DB2 administrator user ID that is used to create the database.</td>
</tr>
<tr>
<td>-password administration_user_ID</td>
<td>Specifies the password for the DB2 administrator user ID.</td>
</tr>
<tr>
<td>-noprompt</td>
<td>Indicates that no prompt will display. This option runs the script in silent mode. Any missing information causes the script to fail. You will not be prompted for any confirmations.</td>
</tr>
</tbody>
</table>

**Example 1:** You are a DB2 administrator and want to create the default GS_DB database on the local node. You run the following command:

```
setupGSDB -createDB -noprompt
```

**Example 2:** You want to create the tables in an existing database named GSDBY, and you want to use the administrator user ID db2admin. Run the following command:

```
setupGSDB -database GSDBY -userid db2admin
```

The script prompts you for the password when it connects to GSDBY. The script will replace any tables that already exist in the GSDBY database, unless you choose to drop the database.

**Optional: Installing the sample data on a remote server**

If the GS_DB sample database is installed on a remote server in your environment, you can link to it by cataloguing the remote database on your local computer and then running the setup script locally.

- If the sample database does not yet exist on the remote server, create it with the `CREATE DATABASE` command. The database requires a UTF-8 codeset and a default table space with a pagesize of 16 KB or larger. For example, on the remote server, create the database by running the following command:

  ```
  CREATE DATABASE GS_DB USING CODESET UTF-8 TERRITORY US PAGESIZE 16k
  ```

- On your local computer, catalog the remote database:

  ```
  db2
  catalog tcpip node nodename remote ipaddr server port_number
  db2 catalog database GS_DB as GS_DB at node nodename
  ```

- On your local computer, run the script:

  ```
  setupGSDB
  -database GS_DB -userid administration_user_ID
  ```

You are prompted for a password to connect to the database.
**Restore Backup Files for Sample Databases for Oracle Using Scripts**

You can use scripts to restore backup files for sample databases for Oracle.

To set up the sample database, you must extract the file GS_DB_ORA.tar.gz, customize a configuration file, and run the setup script.

There are prerequisites for installing the Great Outdoors sample database for Oracle. Before you can install the sample databases, you must verify or configure privileges.

- Extract the GS_DB_ORA.tar.gz file and retain the original directory structure.
- On Linux and UNIX operating systems, modify the file permissions on the setupGSDB.sh file so that it is executable: chmod u+x setupGSDB.sh.
- Ensure that the user ID used to set up the Oracle database has authority to create users and run the import utility.

**Editing the configuration file: Optional**

The configuration file contains the default configuration options that are used when creating the GOSALES data. The default configuration settings are.

<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_IMP_CMD</td>
<td>imp</td>
<td>If necessary can be modified to specify the complete path to the correct version of the import utility.</td>
</tr>
<tr>
<td>GOSALES_INST</td>
<td></td>
<td>Oracle host string.</td>
</tr>
<tr>
<td>GOSALES_TS</td>
<td>GOSALES_TS</td>
<td>If users are created by scripts, used to enter the tablespace name to assign to users.</td>
</tr>
<tr>
<td>GOSALES_CREATE_TS</td>
<td></td>
<td>Optional: Used to create the default tablespace for users.</td>
</tr>
<tr>
<td>GOSALES_TEMP_TS</td>
<td></td>
<td>If users are created by scripts, used to name a temporary tablespace to assign to users. Leave blank to use the default temporary tablespace.</td>
</tr>
<tr>
<td>GOSALES_SCHEMA</td>
<td>GOSALES</td>
<td>Used to enter the username and password for the GOSALES user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALES_SCHEMA_PW</td>
<td>GOSALES_PW</td>
<td></td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA</td>
<td>GOSALESHR</td>
<td></td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA_PW</td>
<td>GOSALESHRPW</td>
<td></td>
</tr>
<tr>
<td>Configuration Setting</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA</td>
<td>GOSALESMR</td>
<td>Used to enter the username and password for the GOSALESMR user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA_PW</td>
<td>GOSALESMRPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA</td>
<td>GOSALESRT</td>
<td>Used to enter the username and password for the GOSALESRT user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA_PW</td>
<td>GOSALESRTPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA</td>
<td>GOSALESDW</td>
<td>Used to enter the username and password for the GOSALESDW user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA_PW</td>
<td>GOSALESDWPW</td>
<td></td>
</tr>
<tr>
<td>GOSALES_GRANTEE</td>
<td>GOSALES</td>
<td>Used to enter the users that will have SELECT, INSERT, DELETE, UPDATE, and ALTER permissions for GOSALES, GOSALESHR, GOSALESMR and GOSALESRT schemas.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The owner of the GOSALES_SCHEMA will always be granted SELECT, INSERT, DELETE, UPDATE and ALTER privilege on all schemas.</td>
</tr>
<tr>
<td>GOSALESDW_GRANTEE</td>
<td>GOSALESDW</td>
<td>Used to enter the users that will have SELECT, INSERT, DELETE, UPDATE and ALTER permissions for GOSALESDW schema.</td>
</tr>
</tbody>
</table>

You can customize the sample configuration file to use settings other than the default values.

The setup script creates the users and schemas specified in the configuration file. In most situations, you can accept the default options. If you want to change the schema names or modify the users or groups that have permissions on the data, you must update the **GOSalesConfig** configuration file.

Edit the configuration file by using a text editor.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSalesConfig.bat</td>
<td>Configuration file on Microsoft Windows operating system</td>
</tr>
<tr>
<td>GOSalesConfig.sh</td>
<td>Configuration file on UNIX</td>
</tr>
</tbody>
</table>
Running the setup script in interactive mode

In interactive mode, the setupGSDB script prompts you to confirm or provide configuration information for the sample database installation. You can accept the default settings or provide different settings to replace the defaults.

- Run the setup script for your operating system.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>In a DOS command window, change to the GS_DB_ORA\win directory and run the setupGSDB.bat script.</td>
</tr>
<tr>
<td>UNIX</td>
<td>From a shell prompt, change to the GS_DB_ORA/unix directory, and run the setupGSDB.sh script.</td>
</tr>
</tbody>
</table>

- Press Enter to proceed. The script will run the sample database setup and display a summary of your choices before you commit to changes to your environment. If you approve the choices, press Enter and the script makes the changes. For example:

Please confirm the following settings:

Instance Name is ORAINST123
Create the following user accounts and import the data:

  GOSALES
  GOSALESHR
  GOSALESMR
  GOSLAESRT
  GOSALESODW

Default tablespace is GOSALES_TS
Temporary tablespace is DEFAULT
Administration User name is sys

WARNING: If the users already exist they will be dropped
Create a Tablespace named GOSALES_TS
Grant select on the GOSALES schemas to GOSALES
Grant select on the GOSALESODW schema to GOSALESODW
Continue creating the sample data with these settings?
(Y/N) Default=Y:

Tip: If you edit UNIX shell scripts in a Windows environment, ensure that you preserve the UNIX line endings.

Running the setup script with command line options

The setupGSDB script lets you provide information on the command line to reduce the number of prompts from the script.

From a command line, run the script for your operating system.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>setupGSDB.bat</td>
</tr>
<tr>
<td>UNIX</td>
<td>setupGSDB.sh</td>
</tr>
</tbody>
</table>

You can run the setupGSDB script with the following options:
Option | Description
--- | ---
-createdb | Creates the users. This option drops any existing users with the same name.
-database database name | Specifies the name of the Oracle instance. This value overrides the default value specified in the configuration file.
-userid administration_user_ID | Specifies the name of the Oracle administrator user ID that is used to create the users.
-password administration_user_ID | Specifies the password for the Oracle administrator user ID.
-noprompt | Indicates that no prompt will display. This option runs the script in silent mode. Any missing information causes the script to fail. You will not be prompted for any confirmations.

Example 1: You are an Oracle administrator and want to create the default sample database schemas. You run the following command:

```
setupGSDB -createDB -noprompt
```

Example 2: You want to create the tables in the existing schemas specified in the configuration file, and you want to use the administrator user ID sys. Run the following command:

```
setupGSDB -YourOracleInstance -userid sys -sysdba
```

The script prompts you for the password when it connects to the Oracle instance. The script deletes any existing tables or views in the specified schemas and replaces them.

Set Up the TM1 Samples

To use the TM1 samples, you must set up the servers, create a shortcut to the configuration file, import the deployment files, and create the data source connections.

To set up the TM1 server samples, unzip and install the greatoutdoors.zip files. To set up the TM1 FinanceFact Server, unzip and install the financefact.zip files. The default installation path for these files is: C:\Program Files\IBM\Cognos\c10\webcontent\samples\datasources\cubes\tm1.

Procedure

1. Ensure that you have the TM1 software installed and the server started.
2. Create a desktop shortcut to the preconfigured location of the TM1s.cfg configuration file. The default location is: C:\Program Files\IBM\Cognos\TM1\bin\tm1s.exe” -z “C:\ProgramFiles\IBM\Cognos\c10\webcontent\samples\datasources\cubes\tm1\greatoutdoors:”.
3. If the location of your configuration file is different, open the configuration file in a text editor and modify it. An example of a basic configuration file is as follows.

Security Mode
• If IntegratedSecurity Mode is set to 1. All clients must provide a database username and password.
• If IntegratedSecurity Mode is set to 2. The clients will have the choice to connect by providing a database username and password or use the single-login mechanism for authentication.
• If IntegratedSecurity Mode is set to 3. All clients must use the single-login mechanism for authentication.

```
TM1S
DataBaseDirectory=C:\ProgramFiles\IBM\Cognos\c10\webcontent\samples\datasources\cubes\tm1\greatoutdoors
LoggingDirectory=C:\ProgramFiles\IBM\Cognos\c10\webcontent\samples\datasources\tm1\greatoutdoors\LogFiles
ServerName=GreatOutdoors
PortNumber=33339
AdminHost=localhost
Language=eng
Protocol=tcp
NetworkFrame=
SaveTime=
DownTime=
RuleTraceOn=
```

For more information about setting up the configuration file and its parameters, see the TM1 Operations Guide.

4. To start the server, launch the desktop shortcut to TM1s.cfg.
5. To import the report deployment files, Sales_plan.zip, Sales_plan_TC.zip, and TM1_FinanceFact.zip, use IBM Cognos Administration.

Results

The Financefact and Salesplan packages are created. These packages connect to the TM1_FinanceFact and TM1_SalesPlan data sources which you must now create in Cognos Administration.

The deployment packages refer to the following data sources.

**Tip:** For Traditional Chinese, use the x_TC packages.

<table>
<thead>
<tr>
<th>Application</th>
<th>Data Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors</td>
<td>TM1_SalesPlan</td>
</tr>
<tr>
<td></td>
<td>TM1_SalesPlan_TC</td>
</tr>
<tr>
<td>FinanceFact</td>
<td>TM1_FinanceFact</td>
</tr>
<tr>
<td></td>
<td>TM1_FinanceFact_TC</td>
</tr>
</tbody>
</table>

The deployment packages refer to the following Report Studio reports.

<table>
<thead>
<tr>
<th>Packages</th>
<th>Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>GreatOutdoors</td>
<td>Best Selling Products</td>
</tr>
<tr>
<td></td>
<td>Channel Pricing Comparison</td>
</tr>
<tr>
<td></td>
<td>Forecast Revenue by Region: Golf Shops</td>
</tr>
<tr>
<td>Packages</td>
<td>Reports</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Golf Shop Sales Forecast - Americas versus</td>
</tr>
<tr>
<td></td>
<td>Asia Pacific</td>
</tr>
<tr>
<td></td>
<td>Gross Margin Forecast</td>
</tr>
<tr>
<td>FinanceFact</td>
<td>Balance Sheet - Americas</td>
</tr>
<tr>
<td></td>
<td>Balance Sheet - Central Europe</td>
</tr>
<tr>
<td></td>
<td>Income Statement</td>
</tr>
<tr>
<td></td>
<td>Source and Application of Funds (Central</td>
</tr>
<tr>
<td></td>
<td>Europe)</td>
</tr>
</tbody>
</table>

**Samples Overview**

This section explains the purpose and content of IBM Cognos Business Intelligence samples. It also discusses the structure and databases of the Sample Outdoors company.

The samples consist of the following:

- Two databases that contain all corporate data, and the related sample models for query and analysis
- Five samples cubes and the related models
- A metrics data source including associated metrics and a strategy map for the consolidated company, and a model for Metric extracts.
- Reports, queries, query templates, and workspaces

To run interactive reports, scripts are required. To see all the reports included in the samples packages, copy the files from the samples content installation into deployment folder and then import the deployments into the IBM Cognos Business Intelligence product.

**The Sample Outdoors Group of Companies**

To make designing examples faster, especially financial examples, some general information about The Sample Outdoors Company is useful.

To look for samples that use particular product features, see the individual sample descriptions in this section.

Revenue for The Sample Outdoors Company comes from corporate stores and from franchise operations. The revenues are consolidated from the wholly-owned subsidiaries. There are six distinct organizations, each with its own departments and sales branches. Five of these are regionally-based companies.

The sixth company, GO Accessories:

- Has its own collection of products, differentiated from the other GO companies by brand, name, price, color and size
- Sells from a single branch to all regions and retailers
- Functions both as an operating company based in Geneva, and as a part owner of the three GO subsidiaries in Europe

The diagram below illustrates the consolidated corporate structure, including the percentage changes in ownership for GO Central Europe, and shows the reporting
Each corporation has the same departmental structure and the same GL structure, shown in the table below. Divisions may not report in the same currencies. For example, the Americas subsidiary reports in US dollars, but the Corporate division local currency is Canadian dollars, and the Operations division local currency is pesos.

<table>
<thead>
<tr>
<th>Division (GL)</th>
<th>Department (GL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate (1700)</td>
<td>Sales (1720)</td>
</tr>
<tr>
<td></td>
<td>Marketing (1750)</td>
</tr>
<tr>
<td></td>
<td>IS&amp;T (1760)</td>
</tr>
<tr>
<td></td>
<td>Human Resources (1730)</td>
</tr>
<tr>
<td></td>
<td>Finance (1740)</td>
</tr>
<tr>
<td></td>
<td>Procurement (1710)</td>
</tr>
<tr>
<td>Operations (1800)</td>
<td>Production and Distribution (1820)</td>
</tr>
<tr>
<td></td>
<td>Customer Service (1820)</td>
</tr>
</tbody>
</table>

Each corporation has a complete chart of accounts. Most of the accounts, such as those under non-personnel expenses, are at the department level, and contain only summary amounts. For example, although each marketing department has expenses, the cost is unspecified at the transaction level where marketing promotions occur.

**Employees**

The Sample Outdoors data contains a full list of employees in all divisions, departments, and locations.
Data is available for reports about bonuses (Global Bonus report) and sales commissions (Sales Commissions for Central Europe report), training (Employee Training by Year report), and performance reviews and employee satisfaction surveys (Employee Satisfaction 2006). If you use Metric Studio, sample metrics for human resources are also available.

In the GO Data Warehouse (analysis) package, groups of measures and the related dimensions are organized into folders. The employees are organized in hierarchies for region and manager, to make different kinds of aggregation easy to report on. Aggregation has been defined for the Employee Position Summary measures, so that Position count and Planned position count aggregate correctly at each level of time: monthly, quarterly, or yearly. For example, see the Planned Headcount report.

The employees are also listed in a sample LDIF file which could be used for any LDAP IBM product authentication including Tivoli®. This authentication directory is necessary for IBM Cognos Planning samples. No other samples depend on security profiles. For more information, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

Sales and Marketing

Data about sales and marketing is available for all of the companies in the Sample Outdoors group.

GO Accessories has richer details to support analysis examples. For example, see the Revenue vs % Profit Margin by Product Brand analysis, based on the Sales and Marketing cube. Marketing and sales campaigns are tied to the Sample Outdoors regional companies.

Overall, the GO companies have experienced solid growth across most product lines (Sales Growth Year Over Year), in all regions (Revenue by GO Subsidiary 2005), because of factors like an increase in repeat business and new or improved products, such as the high margin sunglasses product line. In the product lines sold by the five regional companies (all but GO Accessories) promotions have had mixed success (Promotion Success by Campaign, Bundle and Quarter). If you use Metric Studio, this can also be seen in the sample metrics.

Customer Surveys

The data also contains information from customer surveys. For example, the product line that includes bug spray, sun screen, and so on has not been successful (Product Satisfaction - Outdoor Protection 2005) and a source of retailer dissatisfaction may be the level of customer service rather than the returns (Customer Returns and Satisfaction). If you use Metric Studio, this information can also be monitored in metrics.

Sales Outlets

Revenue from the corporate outlets is available at the transaction level. Revenue from the franchise outlets is available at the consolidated level only (Sales and Marketing cube). Metrics about retailers show that the number of new retail outlets has dropped over the time period covered by this data.

GO Accessories sells worldwide, and sells only accessories. Transaction data for GO Accessories is the primary source for analysis of product by brand, color and size. The other five subsidiaries in the group of companies are regional and sell all...
product lines for retailers in their region. For example, the report Top 10 Retailers in 2005 uses sparklines and list data to review revenues at the retailer level.
Appendix B. Setting up an unattended installation and configuration

Set up an unattended installation and configuration to do the following:

- Install an identical configuration across several computers on your network.
- Automate the installation and configuration process by specifying options and settings for users.
- Install and configure components in a UNIX or Linux operating system that does not have XWindows.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met, and that all your required software is installed and configured.

Procedure

1. Configure a transfer specification file (.ats) to specify installation options.
2. Run the installation tool in silent mode.
3. Use a pre-configured configuration file from another computer.
4. Run the configuration tool in silent mode.

Results

After you complete these tasks, ensure that the IBM Cognos Business Viewpoint installation directory on all computers is protected from unauthorized or inappropriate access. Then you will be ready to use IBM Cognos Business Viewpoint.

Setting up an unattended installation

Use a transfer specification file (.ats) to copy IBM Cognos Business Viewpoint components to your computer without being prompted for information.

By default, each time you install Business Viewpoint using the installation wizard, the options you select are recorded in a transfer specification file. Therefore, if you already installed Business Viewpoint on a sample computer, you can use the generated transfer specification file as a template for unattended installations on different computers.

If you do not use the installation wizard to install components, you can use the default transfer specification file named response.ats that is available on the CD. You must modify the response.ats file for your environment before you can use it for an unattended installation.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

Using a file generated by an installation on another computer

This topic describes how to set up an unattended installation using a file generated by another computer.
### Procedure

1. Use the installation wizard to install Business Viewpoint on one computer.
2. Go to `Business_Viewpoint_installation_location\instlog`.
3. Locate the transfer specification file (.ats) that was generated.
   - The filename format is `ts-BV-version-yyyyymmdd_hhmm.ats`
4. Copy the transfer specification file to the computer where you plan to install Business Viewpoint.
5. On the computer where you plan to install the software, insert the appropriate CD and copy the contents of the CD to your computer.
6. In a text editor, open the transfer specification file that you copied.
7. In the section named License Agreement, change the `ACCEPTED=` property to `y`.
8. Save the transfer specification file in the directory where you copied the contents of the installation CD.
9. Install Business Viewpoint:
   - On a Microsoft Windows operating system, open a **Command Prompt**
     window, and change to the `win32` directory where you copied the contents of the CD, and then type the following command, where `location` is the directory where you copied `filename`, the transfer specification file:
     
     ```
     issetup -s location/filename.ats
     ```
   - On a UNIX or Linux operating system, change to the directory where you copied the contents of the CD, and in the directory for your operating system, type the following command, where `location` is where you copied `filename`, the transfer specification file:
     
     ```
     ./issetup -s location/filename.ats
     ```

### Results

If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the `Business_Viewpoint_installation_location\instlog` directory in a summary error log file. The filename format is `tl-BV-version-yyyyymmdd-hhmm_summary-error.txt`.

If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is `tl-BV-version-yyyyymmdd-hhmm.txt`.

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

### Using the response.ats file

This topic describes how to set up an unattended installation using the `response.ats` file.

#### Procedure

1. On the target computer, insert the CD and copy the contents to your computer.
2. Go to the operating system directory and open the `response.ats` file in a text editor.
Each section in the response.ats file corresponds to a dialog box in the installation wizard.

3. In the section named License Agreement, change the ACCEPTED= property to y.

4. Type the installation location of the program files for IBM Cognos Business Viewpoint Client in APPDIR=location.

   Tip: There should be no space on either side of the equal sign, (=).

5. For IBM Cognos Business Viewpoint Client, in the section named [Component List], next to each component:
   • To install the component, type 1
   • To not install the component, type 0

   Note: All required files are installed.

6. For a Windows installation, for the APPFOLDER= property, type the name of the Start menu folder that contains your program shortcuts.

   Tip: To ensure that the shortcut folder is visible to all users, type 1 for the ALLUSERS_FLAG= property.

7. For the install information in the [Install Conditions] section:
   • To specify the condition is true, type 1
   • To specify the condition is false, type 0

8. Save the response.ats file to a local directory after you make the necessary changes.

9. Go to the operating system directory.

10. At the command prompt type the following command, where location is the directory where you copied response.ats:
    • On the Windows operating system, type
      `isssetup -s location/response.ats`
    • On the UNIX or Linux operating system, type
      `.isssetup -s location/response.ats`

Results

If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the c10_location\instlog directory in a summary error log file. The filename format is tl-BV-version-yyyyymmdd-hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is tl-BV-version-yyyyymmdd-hhmm.txt.

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

Setting up an unattended configuration

Before you set up an unattended configuration, you must export a configuration from another computer that has IBM Cognos Business Viewpoint installed. You can then run IBM Cognos Configuration in silent mode.
The exported configuration contains the properties of IBM Cognos Business Viewpoint that you installed on the source computer.

**Before you begin**

Ensure that the configuration settings on the local computer are appropriate to use to configure another IBM Cognos Business Viewpoint computer with the same installed components.

**Procedure**

1. In IBM Cognos Configuration, click **File > Export as**.
2. To export the current configuration to a different folder, in the **Look in** box, locate and open the folder.
   
   Ensure that the folder is protected from unauthorized or inappropriate access.
3. In the **File name** box, type a name for the configuration file.
4. Click **Save**.
5. Copy the exported configuration file from the source computer or network location to the `Business_Viewpoint_installation_location/configuration` directory on the computer where you plan to do an unattended configuration.
6. Rename the file to `cogstartup.xml`.
7. If you changed the global configuration on the source computer, copy the `coglocale.xml` file from the source computer to the `Business_Viewpoint_installation_location/configuration` directory on the computer where you plan to do an unattended configuration.
8. Go to `Business_Viewpoint_installation_location/bin`.
9. Type the configuration command:
   - On the Windows operating systems, type `cogconfig.bat -s`
   - On the UNIX or Linux operating system, type `./cogconfig.sh -s`

   **Tip:** To view log messages that were generated during an unattended configuration, see the `cogconfig_response.csv` file in the `Business_Viewpoint_installation_location/logs` directory.

   You can check if the unattended configuration was successful by checking the return status. A value of zero (0) indicates success, and all other values indicate an error.

**Results**

IBM Cognos Configuration applies the configuration settings that are specified in the local copy of `cogstartup.xml`, encrypts credentials, generates digital certificates, and starts the Tomcat server.

---

**Setting up an unattended uninstallation**

Use this method to automate the removal of components on several computers that have the same components or to remove components in a UNIX or Linux operating system that does not have XWindows.
Procedure

1. Go to Business_Viewpoint_installation_location/instlog.
2. In a text editor, open the transfer specification .ats file for the product.
   The filename format of the transfer specification .ats file is
   ts-BV-version-yyyyymmdd_hhmm.ats
   If you have more than one .ats file, you only need to edit one of the .ats files.
3. In the section named [Component List], specify the components to remove by doing one of the following:
   • To remove the component, type 1
   • To leave the component installed, type 0
4. Save and close the file.
5. Go to the operating system directory.
6. At the command prompt, type the following command, where filename is the name of the transfer specification .ats file that you edited:
   • On the Windows operating systems,
     uninstall -u -s Business_Viewpoint_installation_location/instlog/filename.ats
   • On the UNIX or Linux operating system,
     ./uninstall -u -s Business_Viewpoint_installation_location/instlog/filename.ats
Appendix C. Troubleshooting

Use this troubleshooting information to help you solve specific problems that you may encounter during or after the installation of IBM Cognos Business Viewpoint Server.

Problems are characterized by their symptoms. Each symptom can be traced to one or more causes by using specific troubleshooting tools and techniques. After being identified, each problem can be fixed by implementing a series of actions.

When you are troubleshooting, log files can help you.

When you cannot resolve a problem, the final resource is your technical support representative. To analyze a problem, your technical support representative requires information about the situation and the symptoms that you are experiencing. To help isolate the problem, collect the necessary data before you contact your representative.

Log files

Log files can help you troubleshoot problems by recording the activities that take place when you work with a product. Operations performed in IBM Cognos Business Viewpoint are recorded in various log files for tracking purposes. For example, if you experienced problems installing IBM Cognos Business Viewpoint Server, consult the transfer log file to learn what activities the installation wizard performed while transferring files.

When troubleshooting, the following files can assist you.

**Cognos Business Viewpoint Server log file**

The default Cognos log file or other log files that you configure to receive log messages from the log server, record information after you start the IBM Cognos service. If you configured another destination for log messages, check the appropriate file or database.

Some log messages indicate problems. Most messages provide information only, but others can help you to diagnose problems in your environment.

Location of the file: `Business_Viewpoint_Server_installation_location\logs` directory

File name: `bvServer.log`

You can change the level of messages that are logged in this file by performing the following steps:
1. Stop the Business Viewpoint Server.
2. Go to the `Business_Viewpoint_Server_installation_location\webapps\bv\WEB-INF\classes\` directory.
3. Edit the `log4j.properties` file.
4. Find the lines that contain the following text:
log4j.logger.com.cognos.mdm.server=DEBUG
log4j.logger.com.cognos.rtpm.server=DEBUG
log4j.logger.com.cognos.rtpm_prototype.server=DEBUG

- To increase the amount of logging, remove the # character at the beginning of each line.
- If logging was previously increased and you want to revert to the original logging settings, add the # character at the beginning of each line.

5. Save the file and restart Business Viewpoint Server.

**Transfer log file**

This file records the activities that the installation wizard performed while transferring files.

Location of the file: Business_Viewpoint_Server_installation_location\instlog directory

File name contains: product name, version, build number, and time stamp

The following is an example of the file name format: tl-BVSERVER-10.1-128.23-20110626_1653.txt

**Transfer summary-error log file**

This file records the components you installed, disk space information, the selections you made in the transfer dialogs, and any errors the installation wizard encountered while transferring components.

Location of the file: Business_Viewpoint_Server_installation_location\instlog directory

File name contains: product name, version, build number, time stamp, and "summary_error"

The following is an example of the file name format: tl-BVSERVER-10.1-128.23-20110626_1653_summary_error.txt

**Startup configuration file**

This file records your configuration choices each time you save your property settings. The file name is cogstartup.xml. If you are unable to save your configuration, or are having problems you can revert to a previously saved configuration file.

Location of the file: Business_Viewpoint_Server_installation_location\configuration directory

File name: cogstartup.xml

**Startup configuration lock file**

This file is created each time you open IBM Cognos Configuration. It prevents you from opening more than one IBM Cognos Configuration window. If you experience problems opening IBM Cognos Configuration, look for the cogstartup.lock file in the configuration directory. If the file exists and IBM Cognos
Configuration is not open, it means that IBM Cognos Configuration did not shut down properly the last time you used it. Delete the lock file and then open IBM Cognos Configuration.

Location of the file: Business_Viewpoint_Server_installation_location/configuration directory

File name: cogstartup.lock

Locale configuration file

This file records the configuration choices you make in IBM Cognos Configuration for product and content locales, locale mapping, and currency support. If you experience problems with language support in the user interface or in reports, use the locale configuration file to track your changes.

Location of the file: Business_Viewpoint_Server_installation_location/configuration directory

File name: coglocale.xml

Uninstallation log file

This file records the activities that the Uninstall wizard performed while uninstalling files. You can use the log file to troubleshoot problems related to uninstalling IBM Cognos Business Viewpoint Server.

Location of the file: Business_Viewpoint_Server_installation_location/instlog directory

File name contains: timestamp and isconfig-UNINSTALL_PACKAGE.log

Cannot initialize a DB2 database

When you start the Tomcat Server, the IBM DB2 database initialization fails. The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

SQLSTATE=54048, sqlcode : -1585 A system temporary table space with sufficient page size does not EXIST.

This message displays because a system temporary tablesapce was not created. Ensure that you create a tablesapce for each of the following types of data:

• Regular
• System temporary
• User temporary

Cannot initialize the SQL Server database

When you start the Tomcat server, the Microsoft SQL Server database initialization fails.

The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

com.cognos.mdm.common.utility.MDMRuntimeException:Database Installation failed
java.sql.SQLException: Login failed for user 'bvsuser'. The user is not associated with a trusted SQL Server connection.

This message displays because the SQL server was not configured to use Mixed Mode authentication.

To fix the problem, start Microsoft SQL Server Configuration Manager and set authentication to SQL Server and Windows Authentication mode.

---

**Cannot initialize a database that was configured using SQL Express**

You configured the Microsoft SQL Server database using Microsoft SQL Express. When you start the Tomcat server, the SQL database initialization fails. The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

Database Installation failed java.sql.SQLException: Unknown server host name 'server_name\SQLEXPRESS'

This message displays because the default SQL Express location, server_name\SQLEXPRESS, was specified in Cognos Configuration as the database server. However, \SQLEXPRESS should not be appended to the server name.

**Procedure**

1. Start Cognos Configuration.
2. In the Explorer window, click Data Access > Business Viewpoint Repository > repository_name.
3. In the Database server with Port number or instance name, type database_computer_name:database_port_number.
4. Restart the Tomcat server.

---

**Unable to read the contents of the keystore**

When you start the Tomcat server, the database and server initialization fails.

The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

ERROR IMdmServer T1 Failed to initialize Business Viewpoint Server.
com.cognos.mdm.common.utility.MDMRuntimeException: Failed to determine configured database type.

Then this message displays:

com.cognos.cclcfgapi.CCLConfigurationException: CAM-CRP-1064 Unable to process the PKCS #7 data because of an internal error. Unable to read the contents of the keystore 'C:/Program Files/IBMCognos/BusinessViewpoint/configuration/csk\jCSKKeystore'.
Reason: java.io.IOException: com.sun.crypto.provider.SealedObjectForKeyProtector

These error messages display because the following events took place:

- IBM Cognos Business Viewpoint Server was configured while the JAVA_HOME environment variable was pointing to the Sun version of Java Runtime Environment (JRE) or JDK. As a result, the product configuration was encrypted by the Sun JRE.
- JAVA_HOME was removed from your environment.
Because JAVA_HOME was no longer set, IBM Cognos Business Viewpoint used the IBM version of JRE that was bundled with IBM Cognos Business Viewpoint Server.

The IBM JRE could not decrypt the product configuration that was originally encrypted by the Sun JRE.

**Procedure**
1. Restore JAVA_HOME back to its original value, pointing to the Sun version of JRE or JDK.
2. Verify that JAVA_HOME is not set. Then reinstall IBM Cognos Business Viewpoint Server and use the IBM JRE.

---

**Java out-of-memory exceptions**

When the server is processing information, java out-of-memory exceptions display. To solve this problem, increase the amount of memory that is allocated for Java.

**Procedure**
1. Start IBM Cognos Configuration.
2. Click **Actions > Stop**.
3. Open a DOS window and go to `installation_location\bin`.
4. Type the following:
   ```cmd
   cmd /c "bbservice.bat uninstall"
   ```
   The Microsoft Windows service is uninstalled.
5. Open the Windows **Services** dialog box and verify that the service was removed.
6. Open the file `installation_location\bin\bbservice.bat` in a text editor.
7. Find the following section:
   ```rem
   set EXTRA_JVM_OPTIONS=-Xmx768m;-XX:MaxNewSize=384m;-XX:NewSize=192m;-XX:MaxPermSize=128m
   rem "for machines with 2GB RAM"
   set EXTRA_JVM_OPTIONS=-Xmx1152m;-XX:MaxNewSize=576m;-XX:NewSize=288m;-XX:MaxPermSize=128m
   rem "for machines with 3GB RAM"
   set EXTRA_JVM_OPTIONS=-Xmx1536m;-XX:MaxNewSize=768m;-XX:NewSize=384m;-XX:MaxPermSize=128m
   ```
8. Comment out the 1GB line.
9. Uncomment either the 2GB or the 3GB line.
10. Save the file.
11. Start the service in IBM Cognos Configuration.

---

**Performance issues with an Oracle database**

You find that IBM Cognos Business Viewpoint Studio has slowed when opening objects. You need to ensure that statistics are current.

**Before you begin**

In the following queries, replace BVSUSER with the actual user name.

**Procedure**
1. In Oracle SQL*Plus, login as the system user.
2. To ensure all tables have monitoring enabled, execute the following SQL:
SELECT TABLE_NAME, MONITORING
FROM dba_tables
WHERE owner = 'BVSUSER'
AND MONITORING = 'NO'
ORDER BY 1

If results are returned, see the Oracle documentation for enabling table monitoring for each returned table.

3. To ensure that the statistics are current, execute the following SQL command:

SELECT TABLE_NAME, to_char(LAST_ANALYZED,'HH24:MI:SS DD-MM-YYYY')
FROM dba_tables
WHERE owner = 'BVSUSER'
AND last_analyzed < systimestamp
ORDER BY 1

4. If the result is not empty, execute the following SQL:

EXECUTE dbms_stats.gather_schema_stats( ownname=>'BVSUSER', options=>'GATHER',
no_invalidate=>FALSE, cascade=>TRUE );

This will force statistics for all tables in the 'BVSUSER' schema to be updated.

---

IBM Cognos Business Viewpoint Service is not connected to the database on the same computer

When IBM Cognos Business Viewpoint Server and its database are installed on the same computer and the computer is rebooted, IBM Cognos Business Viewpoint does not connect to the database.

In most scenarios, the database runs on a different computer than IBM Cognos Business Viewpoint Server. However, if they are installed on the same computer, on startup the IBM Cognos Business Viewpoint service may start before the database service.

To fix this problem, create a dependency in your computer's startup routine so that the IBM Cognos Business Viewpoint service depends on the database service. The dependency ensures that the database service starts before the IBM Cognos Business Viewpoint service starts. To do this, you must edit the Microsoft Windows registry. For more information, see the Microsoft Web site.

**Important:** When you edit the registry, make sure that you follow instructions carefully. If you edit the registry incorrectly, serious problems can occur.

An alternate solution is to change the startup type of the IBM Cognos Business Viewpoint service from Automatic to Manual. If you choose this option, you must manually start the IBM Cognos Business Viewpoint service each time the computer is rebooted.

---

IBM Cognos Business Viewpoint Service does not start because a Windows Service is still running

When you try to start the IBM Cognos Business Viewpoint Service in IBM Cognos Configuration, the service fails to start. You fix the configuration error that caused this problem and restart the service in IBM Cognos Configuration. The service again fails to start because the Microsoft Windows service for IBM Cognos Business Viewpoint is still running.
About this task

The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:
com.cognos.mdm.common.utility.MDM Runtime Exception: Trying
to access the configuration before initialization is completed.

To fix this problem, do the following:

Procedure
1. Stop the IBM Cognos Business Viewpoint Windows Service in the Control
   Panel > Services Console.
2. Restart the service in IBM Cognos Configuration.
Appendix D. Keyboard Shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

**Note:** The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

*Table 14. List of keyboard shortcuts on a Windows operating system*

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX or Linux operating system.

*Table 15. List of keyboard shortcuts on a UNIX or Linux operating system*

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.

*Table 16. List of keyboard shortcuts on the License Agreement page*

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
IBM, the IBM logo, ibm.com, TM1, and Cognos are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “[Copyright and trademark information](https://www.ibm.com/legal/copytrade.shtml)” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
- UNIX is a registered trademark of The Open Group in the United States and other countries.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
Index

A
Active Directory Server
- advanced properties 34
- authenticating in multiple domains 34
- using for authentication 34
- with an LDAP namespace 37
active scripting
- enabling in Web browsers 23
aggregating
- samples and time dimensions 69
application file 46
application servers
- configuring 47
application tier components
- configuration requirements 13
- installing on separate computer 13

authentication
- Active Directory Server 34
- deleting namespaces 40
- domain trees for Active Directory Server 34
- LDAP 36
- LDAP using Active Directory Server 37
- NTLM 39
- testing namespaces 40

B
backing up
- Business Viewpoint information 44
- backing up data 50
- backup data 49
Bind user DN and password property
- special characters for LDAP namespace 36
Business Viewpoint Server
- component description 1
- components 1
- distribution options 11
Business Viewpoint Studio
- component description 1

C
cache_referred files 34
coaststartup.lock file 78
components 1
- application tier components 13
- Business Viewpoint Server 1
- Business Viewpoint Studio 1
gateways 1, 12
IBM Cognos Configuration 1
IBM Cognos Connection 1
- installing on one computer 11
configuration
- backing up 44
- lock file 78
- unable to open IBM Cognos Configuration 78
- unattended 74
- workflows 3

configuration files
- exporting 74
configuring
- Active Directory namespace 34
- application server properties 47
- LDAP namespace 36
- LDAP namespace for Active Directory Server 37
- mail server accounts 29
- NTLM namespace 39
- unattended 74
- Web browsers 23
cookies
- enabling in Web browsers 23
cryptographic keys
- backing up and deleting 44

data
- backing up 50
- IBM Cognos samples 55
- restoring 51
Data Manager Runtime
- 2
database
- backing up 50
- databases
- Business Viewpoint repository 19
- IBM Cognos samples 55
DB2
- repository 19
description of product 1, 77
distribution options 11
domains
- Active Directory Server domain trees 34

e-mail
- configuring mail server accounts 29
environment
- setting up 17
- environment variables
- Business Viewpoint repository 19
- setting for application servers 45
environments
- supported 17
error message
- installing 82
exporting
- configuration files 74
external identity mapping property
- editing for an LDAP namespace 39
External identity mapping property
- special characters for LDAP namespace 36

Firefox
- browser settings 23
G

gateways
  component description 1
  configuration requirements 12
  installing on separate computer 12

I

IBM Cognos
  samples 55
IBM Cognos Business Viewpoint
  system requirements 17
IBM Cognos Configuration
  component description 1
  problems opening 78
  unattended mode 74
IBM Cognos Connection
  component description 1
IBM Cognos samples 55
IBM Cognos TM1 15
IBM DB2
  repository 19
IBM WebSphere
  setting up 43
installation
  workflows 3
installing
  error message 82
  IBM Cognos 8 71
  Sample Outdoors Company samples 55
  unattended install 71, 72
  using transfer specification file (.ats) 71
  using transfer specification files (.ats) 72
Internet Explorer
  browser settings 23

J

Java scripts
  enabling in Web browsers 23

K

keyboard shortcuts 85

L

LDAP
  Active Directory Server 37
    configuring a namespace 36
    editing the External identity mapping property 39
    using for authentication 36
load balancing
  setting 13
log files 77
  Business Viewpoint Server 77
  locale configuration 79
  startup configuration 78
  transfer 78
  transfer summary-error 78
  uninstallation 79
logging databases
  creating 19

M

mail server accounts
  configuring 29
Microsoft SQL Server
  repository 21
migrating to different environment 8, 49, 50, 51
moving data 15
multi_domain_tree 34

N

namespaces
  deleting 40
  testing 40
NTLM 39
  configuring 39
NTLM,
  See Windows native security (NTLM)

O

optimizing
  system 49
Oracle
  repository 21

P

performance 81
preparing to install 17
problems opening IBM Cognos Configuration 78
properties
  configuring for application server 47
purpose of document v, 77

R

repository
  creating 19
  IBM DB2 19
  Microsoft SQL Server 21
  Oracle 21
response.ats file 71
restoring
  samples databases 56
  restoring data 49, 51

S

Sample Outdoors Company 67
Sample Outdoors Company samples
  installing 55
Sample Outdoors,
  See IBM Cognos samples
samples
  employees 69
  installing 55
  restoring backup files using scripts for db2 58
  restoring backup files using scripts for oracle 62
  restoring samples databases 56
  sales and marketing data 69
  setting up 55
The Sample Outdoors Company 67
TM1 65
security
  settings for Web browsers 17
service
  not starting 83
setting up
  samples 55
shortcut keys 85
silent uninstallation 75
special characters
  in LDAP namespace properties 36
starting
  services 83
startup
  configuration lock file 78
supported environments 17
system
  optimizing 49
system requirements 17

T
TM1 15

U
unable to open IBM Cognos Configuration 78
unattended installation 71, 75
uninstalling 52
  unattended 75
upgrading 8, 49
User lookup property
  special characters for LDAP namespace 36

W
Web browsers
  configuring 23
  security settings 17
WebSphere
  application server 47
  setting up 43
Windows native security (NTLM)
  using for authentication 39
workflows
  installation and configuration 3